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HOW TO USE THIS DOCUMENT 

It’s a good bet that when motion capture was first considered as the base for an ETC 

project, no one involved had any idea of the scale or success it would reach.  

Fortunately, a great setup was dovetailed with a strong concept and solid execution.  As 

the MasterMotion Tai Chi trainer project entered its last seven-week cycle, it was 

realized that only through strong continuity could future projects hope to reach the same 

level of achievement.   

This document, and the supplementary materials in the encompassing zip file, provide 

an end-to-end look at what’s required to build a project on the motion capture 

technology.  Chapter one gives a brief overview of motion capture essentials, and 

introduces MasterMotion.  The second chapter covers some of the fundamental 

concepts and figures around a similar project including benchmark data and guest 

planning.  Chapters three and four specify the care and use of the physical and digital 

tools used in motion capture.  Next an in-depth look at the data flow between the 

hardware and software packages will illuminate the complicated interweaving of 

components in the data pipeline.  The sixth chapter provides an all-inclusive inventory 

list for the project, and the text closes with two case studies giving specifics for real-

time and offline motion capture.  Numerous appendices and forms accompany the main 

text, including contact information, external resources, and user study materials. 

While substantial, this document is by no means an overkill and hopefully it gives a 

solid background and answers many questions, saving the reader countless hours in 

development.  Cheers. 

- DV 
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1.  THE ESSENTIALS 

1.1. What is motion capture? 
Motion capture is the use of a magnetic or optical network of markers to obtain and 

record object movement through a three-dimensional space.  The Carnegie Mellon 

motion capture lab uses an optical tracking system consisting of twelve high-end 

cameras that track a set of reflective markers in a space roughly 1200 cubic feet in 

volume.  Markers are placed at key points on the tracked object, which has a 

corresponding virtual skeleton.  A computer receives the trigonometric camera data in 

real-time and processes it, fitting each of the visible markers to a position on the virtual 

skeleton.  The movement of the markers through team allows the recording and analysis 

of a virtual representation of the object. 

 

Figure 1. Motion capture lab and subject 

1.2. What can motion capture be used for?  
Motion capture can be used for a wide variety of entertainment purposes including film, 

television, and video games.  There are also extensive scientific applications involving 

biomechanics, rehabilitation, virtual reality, animal and human movement analysis, 

ergonomics, object tracking and physical training.  Virtually any solid body can be 

tracked (given enough cameras and a large enough space), and its motion, physics, and 

skeleton structure may be analyzed.  Some specific examples of use include improving 

an athlete’s form, obtaining animation data for virtual objects, and ergonomics 

planning.     
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1.3. What is MasterMotion? 
MasterMotion is an ETC student initiative using an optical motion capture system and 

wireless VR to explore how virtual reality can be used to learn structured physical 

movement.  The team’s goal is to create a Tai Chi trainer in which students train one-

on-one with a virtual master. As students try to match the motions of the master, their 

movements are measured by the motion capture system and they receive constant 

feedback on the accuracy of their performance.  Extensive pilot tests were constructed 

investigating how visual feedback impacts the accuracy of students' body positioning. 

In addition, the data noise and latency will be analyzed and reduced in the real-time 

motion capture process. 

 

Figure 2. MasterMotion Tai Chi trainer.  
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2. WHAT TO EXPECT 

2.1. Guests, data, and studies 
This chapter provides a quick overview of some of the environmental issues you may 

encounter in your project.  You’re probably going to be doing extensive user testing to 

ensure you have the best experience possible.  Thusly, a guide to collecting data and 

conducting user studies is included.  To reinforce the concept and theme of the project, 

a guest experience document may be a good idea.  The one developed for 

MasterMotion follows as an example.  Benchmark data for your system’s efficiency 

and thresholds are also listed below so you can have an idea of how your system should 

perform. 

2.2. MasterMotion guest experience 

2.2.1. Guest enters motion capture space 

The motion capture lab has been transformed into an inviting, peaceful place that will 

ease the guest's transition into the virtual world and allow onlookers to get a taste of the 

experience as well: a Chinese door hanging is on the front door of the space, shoes are 

neatly placed next to the door as in a Chinese home, Asian music is playing in the 

background, lighting is low and candles are placed around the space where they will not 

be bumped into. Computer equipment and shelving is hidden from view as much as 

possible using red, gold, and black paper on the walls and tables, or folded into large 

fans.  Tall bamboo stalks add additional color. Paper lanterns hang from the piping on 

the wall opposite the computers.  A slide show of Chinese landscape photos, Asian 

artwork, and people practicing Tai Chi is projected on the front wall.  A yin yang 

symbol is affixed with tape in the center of the floor. A folding changing screen is 

located in the back left corner. Experience operators are dressed in an Asian style and 

bow to the guests when greeting them. 

2.2.2. Suiting up 

After greeting the guest, two of the experience operators lead them to the changing area 

in the far left corner of the space.  Guests change their clothes behind the folding 

screen.  The operators then briefly explain how the motion capture process works and 
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affix the reflective markers.  Affixing the markers will take 30-40 minutes.  The guest 

may have to help the operators locate certain joints or bones on his or her body.    

2.2.3. Calibration 

When the guest is dressed in the motion capture suit, he or she will be told to stand on 

the yin yang symbol in the center of the space.  An operator then leads the guest 

through the static and range-of-motion calibrations.  L-calibration and camera 

sensitivity adjustments are performed before the guest arrives.  Calibration should take 

about ten minutes.       

2.2.4. Transition to virtual world 

After calibration is performed, the guest is led to a point on the floor roughly eight feet 

away from the center of the space.  All lights are turned off, save one lantern at the front 

of the room and one at the rear.  The head-mounted display is placed on the guest.  The 

virtual world he or she sees is completely dark except for a single virtual lantern placed 

where one of the lanterns is in the real room.  The guest can barely make out some kind 

of path in front of them leading to a yin yang symbol on the floor.  A wind chime can 

be heard as well as the gentle lapping of water.  A thin, textured carpet is quietly pulled 

in front of the guest.  The operator holds the guest at the shoulder and leads them down 

the carpet.  As the guest nears the yin yang, the world begins to fade in.  A Tai Chi 

master, dressed in blue, stands facing the guest in an eight-sided pavilion on a small 

island near the shore of a sparkling lake.  Mountains surround the lake and pavilion. A 

small village can be seen in the mountains behind the pavilion facing the lake. It is dusk 

and a full moon can be seen rising into the on one side of the sky.  The orange glow of 

the setting sun can be seen on the other side. The cardinal directions are marked on the 

beams of the pavilion.        

2.2.5. Experience 

When the guest is standing at the Tai Chi symbol, a voice welcomes them and tells 

them to prepare to begin the form.  In the first version of the experience, the operator 

will be the 'man behind the curtain' and will stop the experience at the guest's verbal 

command.  Before the guest starts the form, any duplications of the master or student 

fade into the space.  If the guest wanders out of range, the world will dim. 
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2.2.6. Transition to real world 

When the guest decides to stop training, he or she can enter the real world once again 

by leaving the pavilion via the path.  Again the world will dim so that the only light left 

is a single lantern that corresponds to the rear lantern in the real world.  An operator 

removes the head-mount from the guest and leads him or her to the changing station.  

The lights are raised and the projected slide show is restarted. 

2.3. User study process and protocol 
User testing is a critical phase of your cycle as it provides the best possible path to a 

well-rounded experience.  Since you’re most likely developing for a demographic 

outside of your own, every design decision you make must be validated in user testing.  

What may seem as natural to you may be completely undiscoverable by the next 

person.  In addition to the utility of gauging interface and playability, it can also 

produce very attractive, formal data to prove a point (such as Tai Chi training in VR is a 

great alternative to traditional learning).  While this text will leave the subject matter of 

conducting a good usability test to the experts, there is a thorough presentation of the 

formalized process for conducting a test on campus and assembling your data.  Please 

see the MasterMotion case study for details on this.   
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2.4. Benchmark data 

  

Minimum number of frames to capture when 
calibrating space: 400 

Times to press the round button on the Eye-Trek 
when starting up: 4 

Typical mean residual error after space calibration: 
1.4mm 

Only video resolution available for broadcasting: 
640x480 

Maximum error we allow per camera: 2.0mm Channel to broadcast on: 3 

Normal range for camera sensitivity: 8-9.5 Minimum acceptable steps/sec for Tarsus: 30 

Size of capture area: 10’x15’x7’ Maximum recons on Tarsus before we get 
suspicious: 55 

Number of markers on a human body: 42 Minimum labels: 34 

Number attached to skin (male/female): 21/11 Port to connect to Tarsus on: 800 

Number attached to clothing (male/female): 14/24 Data rate from Tarsus to Saul: 65KB/s 

Approximate length of tape required to mark up the 
Iceland Symphony Orchestra: 210” 

Data rate from Saul to MasterMotion: 12KB/s 

Seconds to capture in the Motorcycle Pose: 3 Frame rate for MasterMotion: 15-30 

Acceptable number of ghost markers in this time: 6 Memory usage for MasterMotion: ~80M 

Speed of data transfer when the Vicon Workstation 
needs to be rebooted: <10kps 

According to Google, number of pages containing 
the word “MasterMotion”: 6 

Maximum mean residual errors for real-time 
subjects: 7.5 

Number of these which describe this project: 2 

Number of LAMARTOs that were built: 3 Number of rechargeable batteries: 32 

Normal RPM for LAMARTO: 60 Number in use by BLARTO: 13 

Voltage required to attain this speed: 9.00 Hours of service before changing batteries: 3 

Pictures taken, for each latency test: 14 Quarts of chocolate milk consumed by 
MasterMotion team in a semester: 116 
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3. PHYSICAL TOOL USE 

3.1. Markers, cameras, and custom hardware 
Essentially, a motion capture system consists of several computers, a set of cameras, 

and about 40 reflective markers.  However, perfecting the use of these materials is a 

fine art.  The markers must be placed in a certain manner on many points of the body, 

and the cameras must be set in delicate alignment.  For real-time VR experiences, a 

wireless video system may also be employed.  The setup, use, and care of these 

components are addressed as follows. 

3.2. Marker setup guide 

      

Figure 3. MasterMotion marker locations (front). 
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3.2.1. Setup possibilities 

The marker placement in this document is only one of many possible combinations.  

This guide will only show the standard marker placement that is used in the motion 

capture laboratory.  The marker placement in this guide resembles the one that is shown 

and explained in the Vicon 512 manual.  As such, the Vicon 512 Manual can offer 

additional information.  The difference with the marker set in this document from the 

Vicon 512 Manual is the addition of 4 markers, namely RARM, LARM, RLEG, and 

LLEG.  

    

Figure 4. MasterMotion marker locations (side). 
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Before starting, here are some general rules of thumb one should follow: 

o Have the person who’s going to be motion captured wear tight fitting 
clothes—strap down any areas of the clothing that is loose.   The marker 
balls’ positions should move as little as possible and should be properly 
seen. 

o Place the marker balls as close to the bone as possible.  This follows the 
rule of having the marker balls stay stationary during movement. 

o To help the motion capture system distinguish the marker balls the left side 
and the right side of the body, place marker balls asymmetrically when 
appropriate.  For example, the RTHI and LTHI, as shown in the picture 
above, are placed asymmetrically from each other. 

o If a marker ball is placed improperly and one decides to reposition it before 
the motion capture begins, replace the tape of the said marker ball with a 
fresh piece to make sure the marker ball will stay put.  If a marker ball falls 
off during the motion capture, one has to recalibrate the subject and redo 
the motion capture in order to get accurate results. 

3.2.2. Head and wrist 

A headband and wristbands with marker balls attached are included with the rest of the 

markers.  Have the subject wear them with the logos facing forward. 

3.2.3. Shoulders 

Place the marker ball on the shoulder bone of the subject.  To 

find the shoulder bone, have the subject move his or her arm up 

and down and find the area of the shoulder that doesn’t move 

when the arm is moved up and down. Do the same for both 

sides. 

3.2.4. Clavicle 

The marker ball for the clavicle should be placed in between the two collarbones and 

below the base of the neck. 



Everything You Ever Wanted to Know (and More) About Mocap 

10/16/02 End-to-end Motion Capture  16 

3.2.5. Elbow 

Find the area where the upper 

arm and forearm connect. Place 

the marker ball above the area of 

the upper arm’s bone that 

connects to the forearm’s bone. 

The marker ball should be place 

along the line connecting the 

upper arm’s bone from one side to the other.  Make sure the marker ball doesn’t 

move when the arm is bent up and down. Do the same for both sides. 

3.2.6. Left hand 

Put the marker ball on the base of the ring finger. 

3.2.7. Right hand 

Put the marker ball on the base of the index finger. 

3.2.8. Upper arm 

Place the marker ball for the upper arm somewhere along the line 

that connects the marker ball on the shoulder and the marker ball on 

the elbow. 

Place the marker ball asymmetrically on the other arm. 

 

 

3.2.9. Forearm 

Place the marker ball for the forearm on the outer edge of the forearm, 

preferably near the edge of the outer bone of the forearm.  Put the marker ball on 

the other forearm asymmetrically. 
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3.2.10. Sternum 

Put the marker ball on the base of the 

middle of the ribcage.  For women, the 

marker ball is placed below the breast so it 

is advisable to tape down that area in order 

to keep the marker ball unobstructed.  

3.2.11. C7 

Have the subject bend his or head down.  The C7 

bone is located along the spinal column right where 

the back of the neck ends.  A small bone jutting out 

will indicate that.  Put the marker ball right on the 

bone. 

 

3.2.12. T10 

The T10 is also located along the spinal column.  Count ten vertebrae down from C7 

and place the marker ball on the tenth. To better see and feel the spinal column, have 

the subject bend down and push his or her shoulders inward. 

3.2.13. Pelvis 

Put the marker balls on the area of the pelvis bone that juts out the 

most.  The figure on the right shows where this is located. 

 

3.2.14. Back Waist 

At the back of the pelvis bone, there are two more areas that jut 

out a little.  Place the marker balls on these areas.  This is 

located at the base of one’s back and right before the buttocks 

start. 
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3.2.15. Foot    

For each foot, put a marker ball on the bone right 

before the toe starts.  Put another marker ball on 

the outer edge of the foot on the bone right before 

the pinky toe starts.  

3.2.16. Ankle 

For the elbow, put the marker ball along the line that connects the 

opposite sides of the anklebone.  

 

3.2.17. Heel 

The marker ball for the heel should be placed on the heel bone 

and it should be placed such that the line connecting the toe 

marker ball and heel marker ball is parallel to the ground. 

3.2.18. Knee 

Have the subject swing his or her lower leg back and forth.  Find the lowest area 

of the upper leg that doesn’t move when the lower leg is moved.  This 

corresponds to the bone right above the ball joint of the knee.  Place the marker 

ball about ½” above the break between the upper and lower leg.  The marker 

ball should also be placed along the line that connects the opposite sides of the 

upper leg’s bone.  Make sure the marker ball doesn’t move when the lower 

leg is swung back and forth. 

For women, the marker balls must be place more to the front than usual.  More 

masculine subjects should have marker balls put a little more to the back since the 

muscle of the legs may move the marker balls during movement. 
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3.2.19. Thigh 

Find the area of the femur that juts out the most to the 

side of the body.  This should be located somewhere 

below the pelvis.  The marker ball should be placed along 

the line that connects the said area of the bone and the 

knee marker ball. Place the marker ball asymmetrically on 

the other thigh. 

3.2.20. Leg 

Visualize a triangle that connects the knee marker ball, 

the ankle marker ball and the opposite side of the 

anklebone.  The marker ball should be placed along the 

line that connects the knee marker ball and the ankle 

marker ball. 

To help the person putting the marker ball visualize the 

line connecting the ankle marker ball and the opposite side of the ankle bone, put a 

paper under the subject’s feet such that the edge of the paper lines up with the line 

connecting the ankle marker ball and the opposite side of the ankle bone.  The person 

might want to ask help from the subject because the best vantage view for visualizing 

the three lines is directly above the subject’s leg. 

Congratulations, your guest is ready for tracking! 

3.3. Camera setup guide 
From time to time, it may be necessary to adjust the cameras used for optical motion 

capture. Reasons for this can include camera malfunction, camera settling, and the 

desire for a differently sized/shaped capture volume.  The procedure for adjusting the 

cameras is simple, and can be done by one person, though it is greatly expedited by 

having two persons two switch for ladder-climbing, component handling, and software 

tweaking. 
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Steps to follow: 

1. Decide which camera layout is needed for your capture.  Typical capture layouts 

include: full-wide, hands, and face.  Full-wide is the most common for body/prop 

capture, and the one addressed in this document.  There should be mounting 

brackets already installed at all the possible camera locations.  For full-wide setup, 

ensure the correct cameras with corresponding lenses are placed as follows. 

 
Figure 5. Full-wide camera layout diagram with focal lense  

measurements (mm).  Vicon WS camera #1 is red in this  

picture, with increasing camera numbers going clockwise from it. 

2. Be very gentle when handling the cameras and lenses, they’re easily 10K a piece.  

disconnect power and signal cables from the back of the cameras before removing a 

camera from a boot.  Connect them before placing the a new camera in a boot so 

you can see what you’re doing. (see Jon below) 
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3. After connecting and mounting the cameras, you have to ensure the correct cables 

are connected to the break-out-boxes’ (BOB) appropriate channels.  You can check 

this by determining the camera number in the figure above step 2, and then tracing 

the camera’s cables to the BOB.  Some of the BOBs will be hard to reach.  Tall, 

daring people are good at this.  Thankfully, some of the cables have colored tape to 

help this process.  When the approrpriate camera light comes on, you know you’ve 

got a match.  The first BOB is near the door of WeH 1334, and services cameras 1-

3.  The following BOBs in clockwise order serve the other 3-tuples. 

 
Figure 6. Break-out-box tuple numbering (1-3 left to right). 

4. Place markers around the physical boundaries of the desired capture space. This 

must include markers at the top of the capture volume (usually a few feet above 
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head height). The upper markers can be placed with the help of the PVC stands that 

are kept in the far right corner of the mocap lab. 

5. Position a ladder under the camera you intend to adjust. 

6. Climb the ladder and adjust the pitch, yaw, and roll of the camera. 

7. Check the Vicon Workstation Live Monitor view from the camera to ensure that 

the camera can see the majority of the space. CAMERAS SHOULD NOT SEE 

EACH OTHER. This is important because the cameras are surrounded by IR 

emitters that will register as large markers in the space.  Concentrate each camera’s 

viewing area to the appropriate set of markers (i.e. far markers on poles for 25mm 

lenses, near pole markers or floorsets for 12.5mm lenses).  It should be apparent 

which cameras will be primarily targeting which region of the mocap space (max 

space is approximately 8’x16’x7’). 

 
Figure 7. Mocap space with pvc alignment trees and axes. 
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Figure 8. Projecting onto a white surface and leading with the  

dynamic calibration wand can expedite and simplify accurate focusing. 

8. Continue to adjust the pitch, roll, and yaw of the camera until satisfied. 

9. Repeat steps 4 - 8 for each camera 

There are several other important things to note. The cameras can be rolled 90º, 180º, or 

270º. If the cameras are rolled, you must change the setting in the Live Monitor. The 

panel where the camera sensitivities are adjusted, you can set this roll angle via a drop-

down menu box. We have never done this ourselves, so you’re on your own. Consult 

the Vicon documentation. Be careful not to change the aperture/focal length of the 

cameras. The correct values are (1.4, 8 ). 

Finally, be aware that when the cameras are on, the IR emitters are blasting IR beams 

all over the place. You may not want to stare into an emitter ring at close range. It could 

be bad. 

3.4. BLARTO and the wireless VR system 

3.4.1. BLARTO 

The guest of the MasterMotion Tai Chi experience will wear a 3 lb. belt around his/her 

waist to carry the equipment necessary to operate the display device. This belt is called 

the BLARTO (Belt-Like-Accessorizing-Technology-Object). It has pockets for carrying 

an X10 video receiver and 2 battery packs. There is also a pocket for the excess cable 
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between the receiver and the controller for the display device (if anyone wants to buy a 

new cable, it should be easy to shorten this length to a more appropriate length). 

3.4.2.  Olympus Eye-Trek VR glasses 

Our system uses the Olympus Eye-Trek FMD-250W video glasses as a lightweight 

head-mounted display for unencumbered VR. The FMD-250W was chosen for its small 

size and its widescreen (16:9) aspect ratio mode, which allows us a 37º horizontal field 

of view. These glasses are currently powered by 5 NiMH AA batteries, which are 

carried by the guest in the BLARTO. Operation of the unit is simple – there is a single 

power button along the edge of the attached controller. Press this to power up the 

glasses. Use the larger “function button” on the front face of the controller to skip the 

warning and enter the password (000) at startup. This button can be pressed at any time 

to bring up a menu for adjusting sound and video properties (including switching 

between 4:3 and 16:9 aspect ratio mode). 

3.4.3.  X10 transmitter/receiver 

Video signal is transmitted to the HMD via small X10 units. The X10 transmitter is 

located in the cable tray directly above the capture space, and gets NTSC signal from 

the client computer with the help of either a scan converter or a video out jack on the 

back of the client computer’s video card and a long wire. The transmitter is capable of 

relaying full quality video and stereo audio to the guest’s HMD. However, the X10 

receiver we chose only accepts monaural sound. We sacrificed stereo sound for a 

smaller size, as this unit is also attached to the guest’s waist, in the BLARTO. The 

receiver is currently powered by eight AA NiMH batteries. Care must be taken to 

switch this unit off after use, as it will not power down on its own. The power switch is 

located along the side of the unit. There is also a channel selector switch on the back of 

the unit. The transmitter is currently set to broadcast on channel 4, so the receiver 

should also be set to channel 4 if you actually want to receive any useful signal. 

Fortunately, the addition of a second transmitter and receiver pair, set to a different 

channel, will allow for multiple guests to share the space. 

3.4.4.  Battery care 

The lab is equipped with a NiMH charger, used to charge batteries for use with the X10 

receiver and the Eye-Trek glasses. Batteries should be charged at least every 4 hours, 
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but can be charged after each use. Used batteries are kept in the “Weak” cup, and 

charged batteries are kept in the “Charged” cup.  

3.5. LAMARTO and the diagnostic unit 

3.5.1. A tool 

LAMARTO (Latency Analysis Measurement Acquisition Rotating Technology Object) 

is not just wood and a motor. LAMARTO is life. LAMARTO is hardware and software 

- a total tool.  LAMARTO is a scientific technology created specifically for the purpose 

of accurately measuring motion capture latency. 

3.5.2. Hardware 

The physical LAMARTO object is a free standing rotating foam core wheel with four 

markers attached to it. It is powered by a variable DC power supply that allows control 

of the rate of rotation. The image of the markers is then projected back onto the foam 

core with a high-contrast projector. The angle formed by the real-world marker, the 

center of rotation, and the virtual marker projected onto the foam core is proportional to 

the system’s total latency and the angular velocity of the foam core. 

 

Figure 9. LAMARTO hardware. 

Using a digital camera, 14 still images are obtained of LAMARTO spinning. These 

may be processed images later with the accompanying LAMARTO software. 
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LAMARTO is typically run at about 60rpm (9V DC). A higher speed (e.g. 120rpm) 

increases the accuracy of the measurement, but can confuse the motion capture system. 

This may lead to unusable data.  

3.5.3. Software 

The LAMARTO software is used to measure the average latency across the 14 digital 

images. Double-clicking on the image will place points on the image (maximum 3). The 

angle between the line from the first point to the second and the line from the second 

point to the third is proportional to the latency. 

 

Figure 10. LAMARTO software. 

LAMARTO keeps a cumulative report on about the latency in the current set of images 

(image right). 

Steps for using LAMARTO: 

• Run LAMARTO.exe. 

• Drag and drop images into LAMARTO. 

• Type rotation speed that the images were taken at in the ‘Motor RPM’ 
text field – do not press ‘enter’ after typing the speed, as that has been 
known to crash LAMARTO from time to time. 
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• Double-click on the image to place points. These points should be placed 
over the real marker on the edge of the foam core, the center marker, and 
the image of the virtual marker on the foam core, in that order. In case of 
a mistake, points can be deleted by double-right-clicking on the image. 

• Press next and back buttons to cycle through open files. 

• Place points on all images. Average latency in milliseconds is displayed 
to the right of the image window. 

• In order to measure angles from another set of images, you must close 
LAMARTO (by pressing OK button) and restart the software. 
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4. DIGITAL TOOL USE 

4.1. The motion capture suite 
Many programs are used to create, maintain and run the MasterMotion suite.  Oxford 

Metrics provides Vicon Workstation and Bodybuilder, which are used to set up for, 

receive, and process motion capture data.  The MasterMotion source itself is rather 

complicated, so an extensive html maintainer’s manual has been generated, in addition 

detailed specifics on how to make use of the networking and filter aspects of the real-

time system have been added.  Throughout the rest of this chapter, the reader will be 

directed to outside sources of documentation to gain experience with the system, and 

several project-specific topics will be covered in depth.   

4.2. Zoom’s guide 
After the first cycle of MasterMotion, it was clear that training new ETC students to 

use the motion capture lab was a daunting task.  Due to the complexity and range of 

elements involved in a simple real-time capture, a tutorial was created for using the 

Vicon station and all of its accoutrements.  Rather than reinvent the wheel, this Zoom’s 

guide for running a motion capture test is included as an appendix to this document.  It 

has plenty of detailed full color pictures illustrating each step of capturing data, both 

real-time and offline, and cleaning it up afterwards.   

The rest of this chapter will go into more detail about the MasterMotion source and 

filtering theoretics. 

4.3. Vicon BodyBuilder 
Vicon Bodybuilder is a software tool used for cleaning up offline motion capture data. 

Since raw motion capture data usually has gaps in some trajectories caused by the 

occlusion of markers, this is very important. Before one starts using BodyBuilder to 

clean up the offline motion capture data, identify all unlabelled markers first in Vicon 

Workstation. 
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Below are some common questions or problems that arise from working with 

BodyBuilder: 

What’s the best way to start cleaning up the trajectories? 

The best way is always to begin at the start of the trajectory. Sometimes, if one starts at 

the middle of a trajectory and changes, the beginning segment of the trajectory is 

affected and may be changed. 

What does one do for a small gap in a trajectory? 

Small gaps are inconsequential enough that one can just “delete and fill” them. The 

software has an intelligent way of interpolating between these small gaps. 

What should one do when there is a large gap in one of the trajectories? 

Copy the same range of trajectories from a marker that moves or acts similarly as the 

trajectory in question. To do this, select the start and end of the gap of the trajectory 

you’re working with. Next, in the skeleton or visual representation, select the marker 

point/trajectory that moves similarly (do not select it at the list of markers because the 

marker point has to be highlighted in the skeleton) and open its graph. Select the same 

range that the gap occurs in the original trajectory. Lastly, go back to the graph of the 

original graph, with the start and end of the gap still selected, and at the menu selection 

go to Edit>Copy Pattern From [name of maker point] 

What if the large gap occurs at the start or end of the trajectory? 

Before you can copy the pattern from a different trajectory, one has to create a start or 

end point first depending whether the gap occurs at the start or end of the trajectory. To 

do this, go to Edit>Add Point then position the point to where it should be or at least 

approximately so. Copy the pattern from another trajectory that moves similarly by 

following the steps stated in the previous answer. 

A marker is labeled wrong in the middle of its trajectory, what should one do so that the 

previous part of the trajectory would not be affected? 

Sometimes, changing the label of the marker in the middle of its trajectory can change 

the marker label for the whole trajectory. To avoid this, one has to snip the trajectory at 

the last point in time where the marker is labeled correctly. By snipping the trajectory, 

the trajectory after the point in time it was snipped will not affect the trajectory before it 

any longer. To snip the trajectory, go to the graph and select the point in time where one 
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wants to snip the trajectory then select Edit>Snip Trajectory. To make the trajectory 

whole again, go to Edit>Flatten Trajectory. 

What’s the easiest way to fix two markers whose labels are switched with each other? 

Go to the point in time where the two markers start to switch labels. Select both 

markers and select Edit>Switch Labels. This switching of labels will only affect the 

trajectory after that specific point in time and preserve the labeling before that point in 

time. 

What are the different files in the subject settings for a model? 

If one goes to Model>Subject Settings, one will find that there are three different files 

to set for a model. The marker file (*.mkr) states what marker points are used and it’s 

relationship with other marker points. This is the same marker file that one uses in 

Vicon Workstation. The model file (*.mod) contains information about the kinematics 

of the skeleton. Model files are usually used for doing biometric experiments, and is 

also required for making the ASF/AMC files because the file states how the skeleton 

should move. More information about how to make a model file can be found in the 

BodyBuilder manual. If one is not doing any biometric experiments and just needs ASF 

and AMC files for 3D animations, the sample model files are usually more than 

adequate. The parameter file (*.mp) is used with model file, and it is basically a file that 

contains the variables a model file uses. One thing that is usually included in the 

parameter file is the length of the limbs of the skeleton. Lastly, the AST file (*.ast) is 

not something that one sets in the subject settings of a model but is required to create 

and ASF and AMC files. It holds the information of the hierarchy for the skeleton and 

the degrees of freedom for each joint. 

4.4. MasterMotion maintainer’s manual 
All of the MasterMotion code has been documented in an html maintainer’s manual 

generated by Doxygen.  By following a set commenting style, classes, methods, and 

procedures used in the MasterMotion code are made clearer and more intelligible, 

making the source easier to learn from and modify.  The complete reference is included 

with the master documentation zip file on the distribution CD and also on randon. 



Everything You Ever Wanted to Know (and More) About Mocap 

10/16/02 End-to-end Motion Capture  31 

4.5. Saul and filtering 
Saul is a core component of the MasterMotion software system whose primary purpose 

is to provide filtered motion capture data to subscribers (MasterMotion client or student 

objects). It requests data from a running Tarsus.exe instance over TCP/IP, performs 

filtering operations on the data, and transmits the data to subscribers via UDP/IP. 

 

Figure 11. Saul connectivity. 

When Saul is started, it sits in a tight loop and waits for a connection on port 2112. In 

order to subscribe to Saul, a client admin program must connect to Saul on port 2112 

and send command messages. The first 4 bytes of a message tell Saul what operation to 

perform. The remainder of the message is a string specifying command-specific 

arguments (this string can be omitted, as in the case of SAUL_PING). Saul will process 

the request and send back a response, usually “OK”. The Message IDs are listed below. 

typedef enum{ 

SAUL_PING  = 0, // Ping Saul 

SAUL_TARSUS  = 1, // Connect Saul to a running Tarsus 

SAUL_SUBSCRIBE = 2, // Make Saul send updates to a host/port 

SAUL_UNSUBSCRIBE = 3, // Unsubscribe a host/port 

SAUL_SETFILTER = 4, // Sets the filter list with 1 or more                                  

SAUL_ADDFILTER = 5, // Adds 1 or more filters to list 

SAUL_CONFIGFILTER = 6, // Send a config string to a filter 

SAUL_INFO  = 7, // Get Subject:Body list from Tarsus 
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SAUL_SHUTDOWN = 8, // Remotely shutdown Saul 

} SaulMessageID; 

In MasterMotion, the MasterMotionServer object owns the admin socket, and sends 

commands to Saul on behalf of itself and its clients. For details, see the 

MasterMotionServer documentation/source. 

While you can define your own Saul filters (by subclassing class Filter in the Saul 

codebase), there are three commonly used filters already defined in Saul: 

• LowPass: A damping filter applied to data produces very smooth data, at 
the cost of perceived latency and loss of important high-frequency data. 
This filter has its uses, but has been mostly replaced by the Kalman 
Filter. The Low-Pass filter has default parameters that provide smooth 
data. To reconfigure, send a message to Saul whose parameters are two 
numbers between 0 and 1 that specify damping amount for position and 
for orientation. Anything from .7 to .99 can provide acceptable results. In 
MasterMotion, type “ConfigureFilterSaul pos rot”, where pos represents 
the desired damping coefficient for position, and rot represents the 
coefficient for the rotational damping. (e.g. “ConfigureFilterSaul 0.9 
0.95”) 

• Kalman Filter: A more flexible, prediction-based filter that smoothes 
data while maintaining important high-frequency data. The default 
parameters should suffice, but if you wish to change them, consult the 
Filtering section of this document. 

• LithtechXform: This is a simple filter that converts data from the Vicon-
standard right-handed Z-up coordinate system to Lithtech’s left-handed 
Y-up coordinate system for correct rendering. 

To set these filters up from MasterMotion, use the following commands: 

• PingSaul 

• ConnectSaul saulhost tarsushost 

• Must be followed by SetSaul 

• SetFilterSaul filter1 [filter2 …] 

• AddFilterSaul filter1 [filter2 …] 

• ConfigureFilterSaul filtername param1 [param2 …] 

• ShutdownSaul 

The other Saul commands (SAUL_SUBSCRIBE, etc) are abstracted from the user, and 

are called automatically by MasterMotion when appropriate. 
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4.5.1. Kalman filtering usage 

4.5.1.1. Files 

The Kalman filter lives inside the Saul architecture. So the files are kept in the \saul 

directory: 

Kalman.cpp and Kalman.h 

KalmanState.cpp and KalmanState.h 

4.5.1.2. Compile 

The filter code uses the Intel Small Matrix Library to increase the computational speed, 

so it needs sml.lib/sml.dll and relative header files (in \sml directory) to compile. 

Starting command 

Command Line>AddFilterSaul Kalman 

Initial values of parameters  

Its initial values are proven to be good enough for most everyday use, so normally they 

don’t need to be changed.  However, should they need to be modified, here are the 

parameters. 

Initial values for body: 

Position_System_Covariance = 0.1 

Position_Measurement_Covariance = 5.0 

Rotation_System_Covariance = 0.01 

Rotation_Measurement_Covariance = 0.5 

Initial values for head: 

Position_System_Covariance = 1.0 

Position_Measurement_Covariance = 100.0 

Rotation_System_Covariance = 0.01 

Rotation_Measurement_Covarianc = 20.0 

Initial values for dimensions (number of previous data points used)  

Dimension = 1 

First_Previous_Point_Ratio = 1.0 
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4.5.1.3. Configuration 

Command Line>SetFilterSaul Kalman <body/head> 

Position_System_Covariance Position_Measurement_Covariance 

Rotation_System_Covariance Rotation_Measurement_Covariance 

[Dimension([1,5]) Second_Previous_Point_Ratio([0~1]) … 

Fifth_Previous_Point_Ratio[0~1]] 

The First_Previous_Point_Ratio can be obtained from the equation, 

1 - Second_Previous_Point_Ratio - … - Fifth_Previous_Point_Ratio[0~1] 

The higher the Measurement_Covariance/System_Covariance ratio, the more 

aggressive the filter performs. The smaller System_Covariance is, the subtler 

information the filter preserves. 

4.5.1.4. For more information on filtering 

• LEE, J., AND SHIN, S. Y. 2002. General construction of time domain 
filters for orientation data. To appear in IEEE Transactions on 
Visualization and Computer Graphics, available at 
http://wings.graphics.cs.cmu.edu/jehee/Papers/TVCG2001.pdf. 

• MURPHY, K., 1999. Kalman filter toolbox for Matlab. Available at 
http://www.cs.berkeley.edu/murphyk/Bayes/kalman.html. 

• WELCH, G., AND BISHOP, G. 2001. An introduction to the Kalman 
filter. In ACM SIGGRAPH 2001 Course Notes. It is available at 
http://www.cs.unc.edu/~tracker/media/pdf/SIGGRAPH2001_CoursePack
_08.pdf. More information is at http://www.cs.unc.edu/~welch/kalman/ 

• The Small Matrix Library offered by Intel. Documentation and source 
code are available at http://developer.intel.com/design/PentiumIII/sml/ 

• The Matrix and Quaternions FAQ web page at 
http://www.cs.ualberta.ca/~andreas/math/matrfaq_latest.html 
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5. DATA FLOW 

5.1. Many cameras, many cables 
From markers on the subject to bone-coordinates in LithTech, motion capture data 

follows a complicated route through several forms.  To help make sense of the wide 

array of hardware and software checkpoints in the MasterMotion system, a detailed set 

of hardware and software diagrams have been constructed.  Minor variations on the 

real-time/offline model are also enumerated in text so you can be sure to have the 

correct configuration for obtaining data. 

5.2. Hardware diagrams 
Several computers handle the tasks of receiving and processing motion capture data.  In 

addition to the hardware boxes, there is an assortment of audio, visual and transmitting 

equipment as well.  A block diagram is shown below, and a full-page version is 

available in the appendix. 

 

Figure 12. MasterMotion hardware layout. 
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5.3. Software diagrams 
Both the MasterMotion client and server-side modules are rather complex, but 

understanding the mocap version of LithTech is easier with the dataflow diagrams  

perspective.  Listed below is an example of one such diagram detailing the server-side 

codebase.  Others like it are included as appendices in full-page versions. 

 

Figure 13. MasterMotion server structure. 



Everything You Ever Wanted to Know (and More) About Mocap 

10/16/02 End-to-end Motion Capture  37 

5.4. Real-time v. offline motion capture  

5.4.1. Subtle differences 

Most of the process in obtaining real-time and offline data is the same, but there are 

some important points to pay attention to.  The rest of the section will delineate these 

issues by area of impact. 

5.4.2. Marker sets 

REAL TIME 

A good deal of luck developed from using the AddHead_HumanRT marker sets for 

real-time capture. This adds an additional forehead marker that stops the head from 

flipping upside down.  It may be a good idea to add vertical offset bars to the hands, so 

that they stop flipping too. There is an untested marker set that does this, 

AddMkrs_HumanRT   

OFFLINE   

Use the HumanRT marker set.  

5.4.3. Body calibration 

REAL TIME 

Do both a static calibration (motorcycle pose) and range of motion.  For rigid objects, 

these can be combined into one calibration.  

OFFLINE  

Only the static calibration is needed. 

5.4.4. Modifying marker sets 

REAL TIME 

Edit the .mkr, .km, and .kmt files.  The .km is the most complex of these, with its 

description of the skeleton  topology and approximate marker locations.  It is easy 

enough to modify though, just remember that the base pose is standing rigid with arms 

at the subject’s sides and palms facing toward the thighs. +X is forward (toward the 

mats on the wall), +Y is to the left, +Z is up. 
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OFFLINE 

This is a complicated and mysterious black art. It involves editing the .MOD file, which 

has been done with limited success. Good luck. 

5.4.5. Data cleanup 

REAL TIME 

All the real time system needs is a set of trajectories, with at least one labeled trajectory 

for each marker in the .km file.  The data can have gaps, can have overlapping 

trajectories, and can have ghost markers.  (Try to avoid the overlapping trajectories 

though).  

OFFLINE 

Offline data needs to be fully cleaned up. There should only be one continuous 

trajectory for each marker in the set.   This means removing any unlabeled trajectories, 

filling all the gaps, and removing any overlapping trajectories. 
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6. DIGITAL/PHYSICAL INVENTORY 

6.1. Grocery shopping for mocap 
A lot of equipment is needed to fill a well-stocked motion capture lab.  Fortunately, 

there is a growing number of teams that make use of the setup in Wean, the materials 

needed are generally well stocked.  However, for reference, this chapter will list end-to-

end all the required paraphernalia for any type of capture setting. 

6.2. Hardware lists and components 

Real-time capture equipment 

• Epson Powerlite703c projector 

• generic 17” monitor for capra.etc 

• A-B video switchbox 

• scan converter 

• x10 transmitter 

• capra.etc.cmu.edu (128.2.184.4) – 2x 866mhz, 256mb ram, GeForce 3 

BLARTO 

• x10 receiver +8 AA batteries 

• Olympus Eye-Trek FMD-250w + 5 AA batteries 

Standard lab equipment 

• generic 10/100 ethernet switch 

• Panasonic WJ-AVE5 digital a/v mixer  

• 2 x Sony Handycam Hi-8 TR818 

• 12 x Vicon 1024x1024 custom greyscale cameras w/ IR filters and 
emitters 

• waltz.graphics.cs.cmu.edu (128.2.184.6) – Dell Precision 420 1ghz, 
512mb ram, video capture card w/ Vicon dongle  

• vicon.graphics.cs.cmu.edu (128.2.184.2) – Vicon 512 workstation 

• Sony STR-DE475 audio receiver w/ room speakers 
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6.3. Software packages 
• Vicon Workstation – this is the main program that is used for motion 

capture 

• Vicon BodyBuilder – this is used for cleaning up offline motion capture 
data and for exporting to ASF/AMC format 

• Tarsus – this is the real-time server that is used with the Vicon 
Workstation to transmit real-time mocap data to another machine / 
software. 

6.4. Miscellaneous materials 
• L-bar with marker balls – for static calibration 

• Wand with marker balls – for dynamic calibration 

• marker balls (at least 41-42 if you are capturing the whole body) 

• headband with 4 marker balls 

• 2 wristbands with a stick that has a marker ball on each end 

• double-sided tape 

• scissors 

• a model of a skeleton (this can be helpful in telling the subject which 
bone you are looking for to attach the marker to)  optional 

• tape – for taping down clothes and any loose clothing optional 

• rubber bands / hair tie / hairpins – for keeping hair from occluding 
marker on the head optional 
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7. CASE STUDIES 

7.1. Tips, tricks, and motion capture  
There are a couple subtle points worth mentioning with regards to a real-time or offline 

motion capture project.  In this chapter, several of the more thorny or nebulous issues in 

a motion capture project are expounded with respect to the MasterMotion and Jam-O-

Elvis projects. 

7.2. MasterMotion, real-time and user studies 

7.2.1. Research and entertainment 

MasterMotion is a pioneer as far as ETC projects are concerned (ask us about the 

arrows later) in that it is the first to produce an academic paper submission.  From the 

beginning, the project goal was not only to develop a Tai Chi trainer but also to 

evaluate its effectiveness and showcase the merits of wireless VR combined with 

motion capture.  Since this is a daunting task for a graduate student in any program, let 

alone one with a non-research curriculum, this section will cover the framework for 

constructing a paper.  A large part of the MasterMotion paper submission was of course 

the user studies, so the details of those user studies are included here as well.  Extra 

information is provided about the filtering process used by the system as a point of 

reference for future real-time projects that may leverage such technology. 

7.2.2. Paper submission 

Russ Schaaf has courteously written a very helpful LaTeX template for paper 

submission.  An example of the template is prepared with a step-by-step process guide 

for writing a high quality SIGGRAPH submission, and is included as an appendix.  The 

digital version of the LaTeX template is available in the master documentation zip file, 

and on randon. 

7.2.3. Real-time filtering  

The real-time data transferred from Vicon system is usually too noisy to be accepted 

directly. Various kinds of flaws occur all the time, like data flipping and shaking. 

Markers may be mislabeled, unseen, or the frame rate may grow unstable, prompting 

these sort of anomalies. Since data cannot be sorted on the Vicon system, the way to 
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reduce these errors to an acceptable level is to filter the data in real-time before it is sent 

to the rendering system. MasterMotion researched, implemented and tested two 

different kinds of real-time filtering techniques: Damping and Discrete Kalman filters, 

ultimately choosing the latter one. 

The Damping filter is a simple first-order recursive (IIR) filter that smoothes data 

curves and removes high frequency information. Basically, it linearly interpolates 

between the current input value and a previous output value given by the expression: 

1)1( −×−+×= nnn yaxay       (1) 

α usually ranges from 0.9~0.99 in our application and tests.  

For the orientation vector, since it is in unit quaternion format, we use the “spline” 

method to do interpolation according to the equation (1). 

Because the Damping filter filters out high frequency information, phenomena such as 

“ice-skating” will appear during the fast motion. The perceived latency caused by the 

filter itself is also quite significant. 

Through analyzing the real-time data, we found that our system can be considered a 

linear stochastic system and the probability of process/measurement error in our system 

roughly obeys Gaussian distribution. Thus, a Discrete Kalman filter was implemented. 

The positional data is a series of three-dimensional vectors that can be linearly 

interpolated, so Discrete Kalman filter was applied to the positional data directly. 

However, the Kalman filter cannot filter the orientation data directly as they are in unit 

quaternion format, which can be considered a point on the unit hyper-sphere 3S . In 

order to apply filtering, we use the method discussed in Jehee Lee and Sung Yong 

Shin’s General Construction of Time-Domain filters for orientation data , which defines 

the three-dimensional vector counterpart of the four-dimensional unit quaternion and 

the transformation relationship between the two. Given a discrete quaternion signal 

}{ 3SqQ i ∈= , its vector counterpart is defined as }{ 3RpP i ∈= . Let 3
0 Sq ∈  and 

3
0 Rp ∈ be the start points of P and Q, respectively. Then, P and Q can be transformed 

to each other as follows: 
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A unit quaternion is denoted as ),,,( zyxwq = , in which 12222 =+++ zyxw . And 

the inverse of a unit quaternion is ),,,(1 zyxwq −−−=− . The logarithm and 

exponentiation operations are defined as below: 

For 3Sq ∈ , 3
1
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For 3Rp ∈ , 
3)sin,(cos)exp( Sp

p
p

pp ∈= ,  ( π<p ) (4) 

By transforming the unit quaternion to its vector counterpart, the Kalman filter can be 

applied as what is done to the position vector. After filtering, the filtered vector 

counterpart is transformed back to unit quaternion format. 

By tuning the parameters of the Discrete Kalman filter (process noise covariance Q and 

measurement noise covariance R), superior filter performance is achieved. Since the 

camera is attached to the body “head” in the first-person point of view and very small 

data flipping on the head can be easily detected in the head mount.  This may make the 

user dizzy, so a set of filter parameters were applied to the “head” data uniquely in 

order to make first-person point of view stable enough while not sacrificing the agility 

of the whole body. In order to minimize the latency caused by the filter, the Intel Small 

Matrix Library (SML) was used in the application to increase the computational speed. 

Multiple previous values were also tested instead of one previous value in the filter 

expression, but the perceived latency increased while data became even smoother. 

Through test and comparison, it was observed that the Discrete Kalman filter smoothes 

the data curve while remaining important high frequency information, and the perceive 

latency is less detectable. Obviously the Discrete Kalman filter performs far superior 

than the Damping filter. 
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7.2.4. User studies and iterative improvement 

7.2.4.1. Forms of testing and data extraction 

The MasterMotion project ran a decent number of user tests in a small amount of time. 

In order to accomplish this, the members of the project determined early on whether 

experiments would be conducted and on which set of subjects. After that, one team 

member was placed in charged of it, and prepared the tests as quickly as possible 

because approval of consent forms for running tests on subjects can take some time. 

Concurrently, the other group members quickly sought help from different sources with 

regards to how to do experiments since they lacked previous experience. One of the 

things that the group learned was that conducting pilot studies is one of the most 

important steps to do before starting with the formal experiment. Pilot studies, or 

informal testing of different things that the experimenters may want to conduct in the 

formal experiment, will show what can be eliminated from the list of possible points to 

test. Pilot studies don’t require any consent forms and are usually conducted on the 

experimenters themselves or their colleagues of the experimenters. In this way, quite a 

bit of time and money can be saved. 

The MasterMotion group quickly conducted pilot studies with appropriate mock-ups of 

the experiment since the system wasn’t fully ready yet. The mock-up proved to be 

valuable in that it allowed parallel development. One setback that the MasterMotion 

encountered was initial uncertainty in the kind of information the group needed to 

support the research hypothesis. Because of this some of the initial data had to be 

thrown out. Furthermore, the formal experiment initially commenced without 

concretely defining the metric for the data.   

Due to a rocky start and a poorly defined set of requirements for the test, the group 

halted all research until a tight specification for these issues was developed.  Testing 

started over at this point and the process ran much smoother. 
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Here are some of the things that was learned from the user testing experience: 

What went right: 

• Decided early and get the consent form early. 

• Had a person responsibly get the consent form and organize the schedules 
for the experiment since this is a time-consuming process where it is best 
to have someone definitely in charge of. 

• Got a mockup up and running ASAP to test things, no matter how small, 
right away. 

• Got outside help quickly on areas unfamiliar to the group. 

What went wrong: 

• Started the experiment without determining first what data was required 
from the subject and what method of measurement was going to be used. 

• Offered CDs with the subject’s experience and information in it as a 
means of compensation—this turned out to be time-consuming and 
eventually ate into some of the time period of the project’s next cycle. 

Suggestions: 

• To get the consent form as quickly as possible.  To avoid being asked to 
revise the consent form more than once, indicate in the application for 
consent forms how the subjects are going to be treated as nicely as 
possible (e.g. subjects will be given time to rest during the tests, all 
subject data would not be personally identifiable at all). 

• Have an organized system for filing all data of subjects. This help in 
getting things done faster. 

• Run pilot tests intensively (one of the professors that was consulted even 
said that the pilot tests should basically show already the result, and the 
formal experiment is used only to confirm the results). 

7.2.4.2. Getting a Consent Form 

The main intent towards getting a consent form is to make all possible risks and 

benefits known to subjects. It also indicates to what extent the testers can do 

experiments on human subjects, and let subjects know the rights that they have. 

It is necessary to get a consent form always when doing experiments on people , 

whether it may or may not pose any risks. This is especially true for physical and 

psychological experiments. If only user-tests are conducted, it is generally not 

necessary to get a consent form unless the user-test may pose some risks that is known 

or unknown to the user. 
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The whole process of getting a consent form may take a considerable amount of time, 

usually Internal Review Board will take about two weeks to process an application. 

After that, it is common that the researcher will be asked to make repeated changes to 

the consent forms to make all necessary information clear to the subjects. 

To apply for a consent form do the following: 

Fill out CMU Human Subjects Clearance Request form. A copy of this form can be 

found in as an appendix. 

Create a Research Plan with the following information: 

• Project Title  

• Principal Investigator—usually the advisor of the project 

• Experimenters—all people who are conducting the tests 

• Proposal or Abstract of experiment—a description of what the project 
aims to do and what kind of tests will be conducted 

• Experiment Procedure—a detailed description of how the experiment will 
be conducted. This should also include the following information: 

• A clear definition of how the subjects will be utilize or the experimental 
treatment will be administered 

• The number of subjects and where the experimenters are going to get 
them 

• The duration of the test for each subject 

• Specific risks and benefits that the subjects may be subjected to 

• What compensation will be given to the subject 

• An indication how confidentiality/anonymity will be protected 

• Name(s) and address(es) of official(s) authorizing access to any subjects 
in cooperating institutions not under the direct control of Carnegie 
Mellon University 

• Risk/Benefit Analysis—what are the potential risks and benefits of the 
study, and whether the benefits far outweigh the potential risks 

A copy of the “informed” consent form(s) that the subjects will be required to sign—

this is basically a contract signed by the subject stating that the subject voluntarily 

agrees to participate in the experiment knowing all the possible risks and his/her rights.  
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This should contain the following: 

• Project Title  

• Names of principal investigator and experimenters with contact 
information 

• Name of IRB Chairperson and contact information 

• Purpose and procedure of the experiment 

• Duration of the experiment 

• Compensation for the subject 

• What steps are taken to protect the subject’s privacy 

• Risks that the subject may be subjected to 

A statement indicating the subject’s voluntary acceptance of the experimentation, his or 

her right to terminate the experiment whenever he or she chooses, and that he or she 

understands everything indicated in the consent form 

A copy of the on-line training certificate for every experimenter and principal 

investigator. The training certificate can be obtained by taking the test at 

http://cme.nci.nih.gov/. The whole training and test can be usually taken in 1-2 hours. 

Any piece of item or document that affects the subjects (e.g. posters advertising for 

volunteers, subject surveys, etc.) 

Submit all these documents to IRB in Warner Hall. 

Note: all copies of documents submitted by the MasterMotion project can be found as 

appendices. 

7.3. Jam-O-Elvis and offline capture 

7.3.1. When to use mocap, when not to 

Motion capture can be a great help to the 3D animator for a variety of projects.  There 

are a number of limitations and tradeoffs, however, that the artist should be aware of 

before deciding to use offline motion capture. 

Motion capture works well because the weight of the animation is really visible.  

Characters that need to move in a believable and realistic manner exhibit a noticeable 

sense of gravity to their actions.  These visual movements are most noticeable in the 

sharp points of data, the quick stops and heavy resonations.  For this reason offline 

motion capture data needs to keep the valid spikes in a session, so filters are a bad idea 



Everything You Ever Wanted to Know (and More) About Mocap 

10/16/02 End-to-end Motion Capture  48 

because they provide constant interpolation, or smoothing between all frames.   Because 

of these behaviors, motion capture works best for developing believable humanoid 

motion, much like the sort of motion viewers are used to seeing in movies.  For 

exaggerated characters, or cartoon-like elasticity, a manual animator is required to 

exaggerate these movements. 

So in short, while motion capture provides good lifelike animation for certain skeletons, 

a lot of extra work is needed to produce the characterizations and mannerisms most 

viewers take for granted in traditional animation.  Still, despite the amount of post-

production work needed to create the correct sense of movement, motion capture can be 

a great starting point for long animation sequences of characters, like running, jumping, 

and other directed paths of complex motion. 

7.3.2. Process 

When constructing a database of animation data for offline capture, each animation 

should be taken separately and played back on Vicon Workstation afterwards to check 

and see if it’s a good enough take for use.  If a lot of trackers are lost and there are gaps 

in the data, it would behoove the animator to do another take, as it will save hours in 

postproduction cleanup and manual filling later. 

The next stage is to clean up the data in BodyBuilder.  Sometimes trajectories will 

separate, and the animator will have to manually tell the program where to connect the 

data points.  Data is initially captured with a 60 keyframes per second rate.  This should 

be toned down when it is exported to Maya to something more manageable like 30, but 

this doesn’t always work properly in BodyBuilder so be sure to include this conversion 

later with the command line converter.  

When exporting, be sure to generate both an .asf (skeleton) and .amc (motion capture) 

file so Maya may process the data.  From this point, the .asf and .amc have to be 

converted to Maya proprietary formats using the programs asf2mel (maya conversion 

skeleton), and amc2mov (maya motion conversion).  These programs should be 

available on either the Vicon Workstation box, or any computer with Maya.  For more 

information on how to use these programs, check the associated man pages.  

Mel is scripting format used by Maya to process certain commands and macros.  The 

animator will need to use the output from the aforementioned asf2mel program to bring 

in a skeleton the size of mocap subject and setup the constraints for each bone and 
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position.  The .mov file is animation data for this skeleton, and should be brought into 

Maya as a scene file. 

7.3.3. A couple notes 

Still motion is hard to do with motion capture.  For example, due to the lack of fidelity 

in the cameras and the bone-fitting process, a motion capture of a subject sitting still 

would could unpleasant vibration, and the data would look jittery and unnatural.  

Unfortunately this would have to be cleaned up later by hand or reduced in density 

(fewer frames) so the interpolation would sift out errant results.  It should also be noted 

that removing spikes in data could be detrimental, for example, when “dropping to 2s” 

(switching to 12 frames instead of 24), the interpolation between points will be visible 

and motion may look erratic or jump, missing important stops and starts. 
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APPENDIX A.  
PREVIOUS MOCAP TEAM MEMBERS 

Project/Cycle  Name Expertise Email (cmu.edu) 

MasterMotion Fall 

’01, Spring ’02 

Russ Schaaf Programming: 

feedback/UI, latency, 

systems, LithTech 

rsbe@andrew. 

MasterMotion Fall 

’01, Spring ’02 

Philo Chua Systems: skeletons, 

models, user testing, 

data mining, website 

pchua@andrew. 

MasterMotion Fall 

’01, Spring ’02 

Ning Hu Programming: 

filtering/Saul 

ning@andrew. 

MasterMotion Fall 

’01, Spring ’02 

Bo Daly Programming: Saul, 

feedback/UI, network, 

LithTech 

rdaly@andrew. 

MasterMotion Fall 

’01 

Rebecca Crivella  Systems: user testing, 

project management, 

website 

rcrivella@andrew. 

MasterMotion 

Spring ’02 

Dave Ventura Systems: project 

management, technical 

writing 

dventura@ 

MasterMotion Fall 

’01, Spring ’02 

Todd Camill ADVISOR camill@andrew. 

MasterMotion Fall 

’01, Spring ’02 

Jessica Hodgins ADVISOR jkh@cc.gatech.edu 

MasterMotion Fall 

’01, Spring ’02 

Gabe Sabourin ARTISTIC  

CONTRACTOR 

gjs@andrew 
 

MasterMotion Fall 

’01, Spring ’02 

Reagan Heller ARTISTIC  

CONTRACTOR 

rch@andrew 
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APPENDIX B. 
EXTERNAL RESOURCES 

Extensive documentation is available for the tools used to create the MasterMotion 

experience.  This material is available both in print form (in the motion capture lab and 

in the mocap project room), and digitally on the distribution CDs and on the web.  

Below are some starting points for learning more about the technologies involved. 

LithTech 3D Graphics Rendering Engine  

http://www.lithtech.com 

Content creation guide and programmer’s guide available in PDF format on the 

LithTech distribution CDs, as well as printed copies in the project room. 

Vicon Motion Capture Systems  

http://www.vicon.com 

Workstation and Bodybuilder reference guides are available in print form in the motion 

capture lab. 

Olympus Eye -Trek VR glasses 

http://www.olympusamerica.com/cpg_section/cpg_eyetrek.asp  

Material on Olympus’s full line of VR glasses are available on their website. 

Wireless X10 Video System 

http://www.x10.com    

The signal the Eye-Trek glasses receives comes from a wireless X10 video transmitter 

system.  A wide array of like-minded products are available on the X10 website. 

Doxygen Documentation System 

http://www.doxygen.org  

Doxygen is an open source program for creating source documentation (C++, Java, IDL 

and C). 
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APPENDIX C. 
USE DOXYGEN LIKE A MASTER 

For your code documenting pleasure, here are some key things that you should know.  

We used the Qt style commenting (C-style comments, with an "!" after the "/*"), as 

follows (taken from docblocks.html in the doxygen html directory)... 

Also, at the start of a file, you should do something like: 

/*! \file structcmd.h 

    \brief A Documented file. 

    Details. 

*/ 

and document any #define like so: 

/*! \def MAX(a,b) 

    \brief A macro that returns the maximum of \a a and \a b. 

    

    Details. 

*/ 

 

If you come across something that you want to add to a to do list: 

/*! /todo Some text describing the things that need to be done 

 */ 

To keep modules documented together, use groups: 

  /*! \addtogroup Saul 

   *  Additional documentation for group `Saul' 

   *  @{ 

   */ 

  /*! 

   *  A function  

   */ 

  void func1() 
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  { 

  } 

  /*! Another function */ 

  void func2() 

  { 

  } 

  /*! @} */ 

 

Here is an example class: 

//!  A test class.  

/*! 

  A more elaborate class description. 

*/ 

class Test 

{ 

  public: 

 

    //! An enum. 

    /*! More detailed enum description. */ 

    enum TEnum {  

                 TVal1, /*!< Enum value TVal1. */   

                 TVal2, /*!< Enum value TVal2. */   

                 TVal3  /*!< Enum value TVal3. */   

               }  

         //! Enum pointer. 

         /*! Details. */ 

         *enumPtr,  

         //! Enum variable. 

         /*! Details. */ 

         enumVar;       
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//! A constructor. 

    /*! 

      A more elaborate description of the constructor. 

    */ 

    Test(); 

 

    //! A destructor. 

    /*! 

      A more elaborate description of the destructor. 

    */ 

   ~Test(); 

     

    //! A normal member taking two arguments and returning an integer 

value. 

    /*! 

      \param a an integer argument. 

      \param s a constant character pointer. 

      \return The test results 

      \sa Test(), ~Test(), testMeToo() and publicVar() 

    */ 

    int testMe(int a,const char *s); 

        

    //! A pure virtual member. 

    /*! 

      \sa testMe() 

      \param c1 the first argument. 

      \param c2 the second argument. 

    */ 

    virtual void testMeToo(char c1,char c2) = 0;    

     



Everything You Ever Wanted to Know (and More) About Mocap 

10/16/02 End-to-end Motion Capture  55 

//! A public variable. 

    /*! 

      Details. 

    */ 

    int publicVar; 

        

    //! A function variable. 

    /*! 

      Details. 

    */ 

    int (*handler)(int a,int b); 

};  
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APPENDIX D. 
REALLY ANNOYING THINGS 
(TROUBLESHOOTING) 

This section will hopefully grow in the future, because it may be one of the most useful.  

Here all the annoying little problems that could waste your time will be addressed as 

they are encountered. 

Why am I getting lousy orientation data from the gloves? 

Unfortunately, the gloves are less than ideal rigid bodies (the wrists slide a lot, and 

almost all the trackers are in the same plane), so it’s easy for Vicon to get confused and 

give you an incorrect +X,Y,or Z vector component.  This is really problemsome for 

pointing or ray-casting applications.  A sure-fire way to tell if any object is giving the 

wrong orientation data is to run the real-time viewer on Waltz and look at the bodies 

and their individual Vicon-aware coodinate systems.  Trying a similar object with a 

better sense of forward (like a  staff) also may help shed some light. 

What is the “right” way to do static calibration of the space? 

Lots of people calibrate different ways.  You should pick one, and ALWAYS use the 

same.  That way no one gets mislead as to which direction is forward, up, etc.  We use 

the method of +X to the far wall where the stage is, and the +Y towards the doors.  This 

can screw everything up if you’re not calibrated properly from the get go.  So think 

about it! (See image below.) 
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APPENDIX E. 
DIAGRAMS, SCHEMATICS, FORMS 
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OFFLINE CAPTURE 
 
 

PRELIMINARIES 
 
Know the Lab. 
 
There are five (5) machines in the MoCap studio. The leftmost computer, “Waltz,” 
is the machine that you will use to do all of the Motion Capture and cleanup work.  
 
Next to Waltz is the Vicon capture machine, which must be networked to Waltz 
for anything to work. 
 
 
 

 
The white box here is the Vicon machine. it’s a good box, but can be a little tempermental. If it 
gives you any trouble, turn it off and on with the switch on the lower right. 
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Next to the Vicon machine is an SGI. 
 
To the right of the SGI, on the other table, is a large black box, the MotionStar 
machine, which is used to process data from the magnetic tracking system in the 
lab. 
 
To the right of the MotionStar box, past the A/V equipment, is a monitor that is 
used for both the realtime server, “Rumba” (the black Dell on the floor) and the 
realtime playback machine, “Muybridge.hcii”, which is running alice. 
 
 
 
 
 
 
 

 
Say hello to Russ if you see him down there. He gets lonely sometimes… 
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Know the Software. 
 
On Waltz, you will find a desktop shortcut to a program called Workstation. This 
is the program that you will use to record motion and to build a skeleton from the 
MoCap data. 
You will also find a shortcut to Bodybuilder. This tool will be used later to clean 
up the data that you’ve recorded. 
 
 
 
 
To begin Capturing Motion, run Workstation. 
 

 



 5

 
 
 
 
 
From the File Menu, Open the ETC MoCap Database: 

File->Open Database->ETC 

 
 
 
This, of course assumes that you’re in the ETC. Otherwise, you may want to 
make a new database somehow. 
 
That’s it for the preliminaries. Now you’re ready to get calibrated and get 
jiggy.
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STEP I: Calibration 
 
 
The first time you enter the MoCap Studio in WH1328, you will have to calibrate 
the Vicon Motion Capture System to ensure precise measurements. After initially 
calibrating the system, you should be able to use it without recalibration, provided 
the cameras are not moved in the studio. 
 
Place the Static Calibration Axes on the floor as shown in the picture. In the 
center of the performance space, there is a large, blue, asterisk-shaped marking 
on the floor. Near this marking are two markings at right angles. Align the Axes 
approximately with these markings. 
 
 

 
This isn’t really a precise science. Just get the axes near the center of the 
capture space, which is delimited by blue markings on the floor. 
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The first order of business is to ensure that all of the cameras can see the axes. 
Click on Camera Icon (the 5th button from the left) to bring up Live Monitor. 
 

 
 
Click the arrow buttons in the lower left to cycle through all of the cameras, 
making sure all 12 cameras can see axes.. 
 
If all is well, close the LiveMonitor. If all is not well, you may have to re-aim the 
cameras or clear all lines of sight to the axes. Reaiming the cameras is beyond 
the scope of this document. You should never have to do this, and should not 
attempt it without parental supervision. 
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Press the “Calibrate Button” – the 6th button from left on the toolbar 
 
 

 
 
 
The calibration process involves a static calibration and a dynamic calibration 
step. To begin calibration, press the “Calibrate” button. 
 
Press start button to start the static calibration. 
After approx. 3 seconds, the calibration should automatically stop. If it takes 
substantially longer (10 sec or more) or says “initializing”, you will have to hard 
boot the Vicon machine and restart the Workstation program to try again. 
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After the static calibration phase, remove the axes from the stage, and take out 
the calibration wand. 
 

 
 
This is the dynamic calibration wand (in the clear space capsule). It lives near all 
of the other markers behind the magic black curtain. Remember to close the 
curtain before capturing, as the reflections form the objects inside will screw up 
your data. 
 
This, by the way, is the reason why we aren’t allowed to wear shoes in the lab. 
Aside from possibly damaging the special squishy floor, many shoes have highly 
reflective materials that reflect the IR light from the cameras. 



 10 

 
 
 
Press start button again to begin the dynamic calibration step. 
Walk around the stage area and wave wand around. Workstation will display a 
count of the number of frames taken. Go about 400 frames, or until you’ve 
covered entire space, and then press the stop button. 
 
 

 
 
Be sure to spend a good amount of the time waving the wand near the corners of 
the space. The lower bound is the floor, and the upper bound is a little higher 
than head level. You still have to do the other areas, but the corners require a 
little more attention. 
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The software will now display threshold and tolerance data. Make sure that the 
data displayed for each camera is less than 2mm. If this is not the case, repeat 
the calibration step, making sure to cover the entire stage with the wand 
(perhaps more slowly) during the dynamic calibration step. 
 

 
 
You should try to beat the record of 1.2mm error. That record was mine. Philo is 
not good at this at all. Russ has gotten an error measurement larger than the 
room, larger than CMU. It was a few kilometers…
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The next thing you have to do is to calibrate the sensitivity of the camera.  Having 
the camera too sensitive will have some of the marker balls show up more than 
once.  On the other hand, if the camera is not sensitive at all, it will miss some of 
the marker balls.  Go through each of the camera and adjust the sensitivity on 
the right, as pointed by the arrow in the picture. 
 
The best way to calibrate the camera sensitivity is to have the subject that you 
are going to capture go to the four corners of the area that can be seen by the 
camera and adjust the camera sensitivity at each corner. 



 13 

 
 
 
STEP II: SET UP SCENE OBJECTS 
 
 
Now you will prepare the scene to capture. Click the 1st button to open project 
window. 
 

 
 
From the menu, select Trial-> Define Subjects, and press “New”. 
Type in the name you wish to give to an object in your scene. For example, if 
there is a chair in your scene, you may wish to create a subject named “chair”. 
Repeat this step for each object in your scene.  
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For each object in your scene: 

1) Press the “Circle K” button to create a new “trial” 
2) In the Trial Type dropdown, select “VR subject calibration” 
3) Select the current object name from subjects list (e.g. “chair”) 
4) Press “Types” button 
5) Select an appropriate marker set to describe the current object. In the 

case of the chair, the marker set to use is called 
“C:\stage3\vanillaDemo\chair.mkr” 

6) Press the capture button to get static data 
7) Stop the calibration after a few seconds 
8) Assign labels to all markers on object by clicking first on a marker (or 

sequence of markers) and then on the corresponding label (or series of 
labels) 
To determine which marker is which, consult the appropriate .km file 

(chair.km) 
9) From the menu, select Trial-> Create Autolabel Calibration and press 

OK 
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NOTE: 
 
For human subjects, there are two positions that best calibrate the subject.  The 
first one is the T-position where the subject has his or her feet shoulder width 
apart and his or her arm raised up to his or her side with the thumb facing up and 
the palm facing forward.  The second position is the motorcycle position.  In this 
position, the subject assumes a position as though he or she is riding a bike.  
The subject has his or her legs bent and both arms raised to the front.  The 
motorcycle position is used more often.  During subject calibration the subject 
must stay as still as possible. 
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STEP III: RANGE OF MOTION CALIBRATION/CAPTURE 
 
Press the “Circle-K” button to create a new trial, but this time, set the trial type to 
“VR Range Motion”. 
 
If you intend to use the subject for online (real-time) motion capture later, press 
the “Pipeline” button. A list of checkboxes should appear. Check “Distance 
Statistics Collection Process,” and then press the “Options” button. In the dialog 
box, make sure that an appropriate .km file is specified. Also check “Realtime 
Subject Calibrator” and in its options dialog, specify the same .km file as you did 
for “Distance Statistics Collection Process.” 
 
 

 
 
 
For online or offline capture, start recording and move the object through its 
range of motion. For a human subject, s/he should move all joints through their 
entire range of motion – roll the neck, bent the elbows, circle the shoulders, etc. 
Stop the capture. 
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The markers in the capture file should automatically label themselves according 
to the correlation established in the previous section. To verify that this is the 
case, make sure that the Mode in the lower right is set to “select” and pick the 
vertices. They should show labels on MouseOver. 
 
If the markers are incorrectly labeled, you can reassign them as above. Note also 
that if a marker goes out of sight for a long period, the computer may be unable 
to accurately map the markers to their labels. In this case, you must manually 
specify the label/marker pairings. 
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STEP IV: Data Cleanup 
 
IF YOU ARE DOING REAL-TIME MOCAP, DO NOT FILL ANY GAPS!!! 
 
If you are doing off-line capture only, it will be necessary to clean the capture 
data to fill in any gaps. Much of this can be done by automatically filling gaps. 
 
Open Bodybuilder (shortcut on desktop). This is the Vicon software used to clean 
up the data and also to analyze the data for biokinetic measurements. You will 
use it to do data cleanup on all of your captures. 
 
When you first open the c3d file you are going to clean up, you’ll see the motion 
on top of a grid floor.  The motions that lie in the area of the grid floor is the best 
data so you might want to crop out the motions that lies outside the grid floor. 
You can do this by moving the timeline and closing and opening the file again. 
 
From the menu, select Edit -> Fill All Gaps.  You can also specify the maximum 
gap that you want to fill by going to the menu and setting the Maximum Fill Gap. 
 
This should take care of any small gaps that there may be in the data. 
Unfortunately, the larger gaps will require some personal attention. 
 
Identify a gap in the data. You can watch the capture by pressing play in the 
lower left corner of the capture playback window. Any gaps in the data that were 
too large for the auto-cleaner should be obvious and easy to spot. Once you 
have spotted a gap in the data, select the offending marker, and double click to 
view graphs of its position in 3 dimensions. Find the gap in the data and click the 
ends of the lines. From the menu, click on both loose ends of the data 
surrounding the gap, and fill it from the menu. Click the “weighted dragging” 
button and manually adjust the curves to smoothly interpolate the data. This is as 
much an art as it is a science, but if you loot at other markers that are moving 
similarly, you should be able to come up with a reasonable approximation. For 
instance, if you are filling in gaps in the C7 marker at the top of the back, you 
may do well to model its motion after the motions of the clavicle and the sternum. 
 
 
 
Now it’s time…
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STEP V: Offline MoCap 
 
You are now ready to capture and clean whatever animation data you want. The 
process is the same as in steps III and IV, with the exception that when creating 
the new trial, the Trial Type should be set to “General Capture”, rather than “VR 
Range Motion.” 
 
There isn’t much to say about this. Start the trial, do your thing, and stop the trial. 
The Workstation software will then take its sweet time processing the data. Bring 
a Snickers bar. 
 
You will surely have to do some data cleanup if your capture is long and 
complex, or even short and sweet. You’ll be there for a while, but it’s better than 
hand animating it, right? 
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STEP VI: Exporting Data to 3dStudioMax or Maya 
 
To import the data to 3D Studio Max or Maya, you need to export the data to an 
ASF and AMC file.  The ASF and AMC files are common, and more or less 
standard, file formats for motion capture data.  The ASF file contains the skeleton 
information of the subject.  The AMC file contains all the motions of the subject; 
to reconstruct the motion, you will need the appropriate ASF file. 
 
The steps here will only show you how to export the .c3d file of the vicon system 
into an ASF and AMC file.  To import it into 3D Studio Max or Maya, you will 
need the necessary plugins and they have their own steps. 
 
To create the ASF file:  
1) Open Bodybuilder 
2) Open the c3d file for the subject calibration (either the T-position or 

motorbike position for human subjects) 
3) In ModelàSubject Settings, set .mp file.  A list of different .mp files can be 

found in C:\Vicon\Model.  Copy the one that you want to use and put it in 
your directory. 

4) Select ModelàCreate ASF file 
 
To create the AMC file: 
1) Open Bodybuilder 
2) Open the c3d file you want to use 
3) Select Modelàcreate AMC file 

 
 
NOTE: 
You can create your own .mod and .mp files if you need a different kind of 
skeleton.  Check the Bodybuilder manual for more information.
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ONLINE (REALTIME) CAPTURE 

 
 
 
 
If you’ve gotten this far, you should have no problem capturing animation data 
and playing it back in realtime. 
 
For a realtime capture, do everything that you would for an offline capture, up to 
and including step III. You must also register these objects as capable of real-
time capture by selecting RealTime->Add Subjects from the menu and adding 
them to the list. 
 
Then, on the Realtime Server (Rumba.graphics), run the Tarsus Server program, 
Tarsus.exe, which is located in the Tarsus folder on the desktop. You could 
actually run this program on any machine. If you run it on Waltz instead of 
Rumba (for example), expect it to take up about  66% of your processor time 
(this means no video capture).  
 
Connect Workstation on Waltz to Tarsus (on Rumba or another machine) by 
pressing the “connect to realtime server” button in Workstation (13th button on 
bar – looks like pipe w/ arrow) or selecting Realtime->Connect from the menu. 
 
Check the Tarsus server on Rumba to make sure there are no errors, and press 
the “activate” button in Workstation (Waltz, to the right of the “connect” button). 
Data should now be flowing through the real-time server.  
 
Read the Tarsus protocol documentation for an overview of how the data is sent 
to your real-time applications. 
 
If you don’t care to write your own application, start up Alice on Muybridge.hcii  
(the rightmost computer) and load up an Alice world containing models 
corresponding to the objects you are motion capturing. In the Behaviors, you 
need a ViconBehavior, and the script must contain code to map the real-time 
data to the objects. See Stage3’s sample world for further information about 
mapping bodies to objects in Alice. To see the output of the world on the 
HMD/projector, be sure to press <ALT>+<ENTER> on the Muybridge.hcii 
keyboard (and, of course, make sure the HMD/projector is on). 
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About the <Wireless> HMD 
 
The “wireless” HMD lives on the table near Muybridge, in the corner of the lab. 
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The HMD is powered by a battery pack, carried in the blue backpack. When 
charging, the battery pack will be off. MAKE SURE TO TURN IT OFF WHEN 
YOU RECHARGE IT! 
 
 

 
 
 
Even Rebecca knows where the power switch is. 
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The HMD gets its video signal from an X10 video receiver, also carried in the 
backpack (yeah, it’s kind of heavy). This receiver gets signals from a transmitter 
in the ceiling above the (0,0,0) point of the room (the place you put the axes for 
static calibration). This transmitter can broadcast on either channel 3 or channel 
4. It doesn’t matter which it is, but make sure that the X10 receiver in the 
backpack is on the same channel. 
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You may have to stand on a chair to see what channel the transmitter is 
broadcasting on. 
 

 
 
Becca points at the transmitter. The receiver is in her left hand. They’re both on 
channel 4. 
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Oh, and one more thing… as of the writing of this manual, the HMD is a Sony 
Glasstron from Japan, and its buttons are labeled in Japanese. FYI: the 
Japanese word equivalent of “power” is “? ? ” – making the power button the 
slider with the arrow next to it. Below this, you will find a “? ? ? ? ” (English: 
“start”) button, that you will have to press several times when you first power up 
the device in order to get a picture. 
 

 
 
That’s about it for the Zoom Guide to MoCap. If you have any other questions… 
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Oh, and when you’re done… 
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(just kidding) 
 
- Zoom 
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Tarsus communications protocol overview 
 

After connecting to Tarsus the first step a client should execute is to request an info 
packet (see Communications Protocol). Tarsus will reply with a packet containing an array 
of strings. These strings inform the client exactly what data is contained in each channel 
(see Channel Specifications). When the client makes subsequent requests for a data packet, 
Tarsus will send back an array of real numbers (doubles) where the position of each value 
indicates which channel it corresponds to. (i.e. the nth value in the data packet corresponds 
to the nth string in the info packet). It is then a simple matter to parse the incoming data.  

Each value in the data packet will constitute a length or part of an angle. All of the 
lengths are in millimetres and the angles in radians; the angles are parameterised as angle-
axis triplets. In angle-axis parameterisation, the direction of the vector indicates the axis of 
rotation and the magnitude indicates the amount of rotation. Clearly, all three components 
of the angle-axis are required in order to make any sense of the data.  
 



Channel Specifications 
 

Outline 
 
The Vicon Realtime System communicates all the human motion it captures with graphics packages 
using named channels.  A channel is a time-varying double value, described in detail in the 
Communications Protocol document. 
 
To allow the client of this data to understand the meaning of this data, extra information is encoded 
into the channel name.  This document describes the format of the channel names. 
 

Scales 
 
All angular values are communicated in radians.  
 
All translation values are in millimeters in a z-up world. 
 

Channel Names 
 
The Channel Name is formatted: 
 
Name <Codes> 
 

Name 
 
SegmentName 
MarkerName 
 
The channel name is either a segment name or the marker name.  The same name can appear 
more than once with different codes.  Segment names and marker names may have an optional 
Subject Prefix. 
 
SubjectName:SegmentName 
SubjectName:MarkerName 
 
The Name must not contain the characters ' ', '-', '<', or '>'. 
 

Codes 
 
The codes are bracketed with '<' and '>' to allow them to be easily identified. 
 

Time 
 
<F>  The channel is a frame number, as a double.   
 
The name of the channel is 'Time x fps' where x is the frame rate in frames per second that the 
number refers to.  



 

Markers 
 
<P-X>  The position down the X axis. 
<P-Y>  The position down the Y axis. 
<P-Z>  The position down the Z axis. 
<P-O>  Is the marker occluded.  (1.0 = occluded, 0.0 = visible) 
 
The positions of the reconstructed markers for that sample. 
 

Bodies 
 
<A-X>  Angle-Axis Rotation about the X axis. 
<A-Y>  Angle-Axis Rotation about the Y axis. 
<A-Z>  Angle-Axis Rotation about the Z axis. 
<T-X>  The translation down the X axis. 
<T-Y>  The translation down the Y axis. 
<T-Z>  The translation down the Z axis. 
 
The kinematic bodies are communicated in global space.  The rotation is an Angle-Axis 
parameterisation.  (See Note) 
 



Kinematic State 
 
Free Moving  
 
For example, the pelvis. 
 
<a-X>  Angle-Axis Rotation about the X axis. 
<a-Y>  Angle-Axis Rotation about the Y axis. 
<a-Z>  Angle-Axis Rotation about the Z axis. 
<t-X>  The translation down the X axis. 
<t-Y>  The translation down the Y axis. 
<t-Z>  The translation down the Z axis. 
 
This is exactly the same format as for bodies, but the information is local. 
 
Ball Joints  
 
<a-X>  Rotation about the X axis. 
<a-Y>  Rotation about the Y axis. 
<a-Z>  Rotation about the Z axis. 
 
See the note about rotations. 
 
2 DOF Joints  
 
<a-A>  Rotation about the primary axis. 
<a-B>  Rotation about the secondary axis. 
 
Hinge Joints  
 
<a-H>  Rotation about the Hinge axis. 
 

Rotations 
 

The 3 DOF rotations are parameterized as Angle-Axis triplets, (also known as Finite Axis of 
Rotation and Exponential Maps).   

 
The normalised vector is the axis of rotation.  
The magnitude of the vector is the amount of rotation (in radians). 
 
Therefore: given (ax,ay,az) as angle axis params, 
Rotation about axis of rotation is theta = sqrt(ax*ax+ay*ay+az*az) 
Axis of rotation is A = (1/theta)*(ax,ay,az) 
 
For a good discussion of rotation parameterization see:  
 
F. Sebastian Grassia. Practical Parameterization of Rotations Using the Exponential Map. Journal 
of Graphics Tools, 3(3):29-48, 1998 
 
 



Communications Protocol 
 

Outline 
 
The Vicon Realtime System communicates the human motion it captures with graphics packages 
for rendering using a client / server paradigm.   
 
Server  - Vicon Realtime (Tarsus) 
Client  - One or more Graphics packages. 
 
The graphics systems that need to be supported are: Maya, Max, Soft and Kaydara.  The 
communication takes places through TCP/IP (Stream Sockets). 
 
The client connects to a server socket on a predefined port.  (currently 800)   
 
It sends a request for information, to which the server replies with the names of the various 
channels that are available. 
 
Then, repetitively, the client sends a request for data.  The server replies with a sequence of 
doubles, where each double corresponds with one of the names. 
 
This low level protol can be easily integrated with the channels systems that exist in Maya, Max, 
Soft .  Higher level information will be available by encoding meaning in the channel names.  For 
example 'Time F' corresponds to a frame count, 'hip - RX' is the X rotation of the hip, that sort of 
thing. 
 

Protocol 
 
Currently the byte order and double formats are that of NT. 
 

Packet 
 
| Packet  | Type |                       Body                            | 
 
Packet 
long int 
0 - Close 
1 - Info 
2 - Data 
3 - Streaming On 
4 - Streaming Off 
 
Type 
long int  
0 - Request 
1 - Reply 
 



Close 
 
If the Packet is identified as a Close, there is no Body. 
 

Data 
 
If the Packet is identified as a Data packet the Body is: 
 
| Count | Value | Value | Value | Value | . . . 
 
Count  
long int 
The number of values to recieve. 
 
Value 
double 
The channel value. 
 

Info 
 
If the Packet is identified as a Info packet the Body is: 
 
| Count | String  | String | String | String | . . . 
 
Count  
long int 
The number of strings to recieve. 
 

String 
 
| Letters | char | char | char | char | . . .  
 
The channel name without a terminating '\0'. 
 
Letters 
long int  
The number of characters to read.  
 

Higher Level 
 
Additional information is encoded in the string itself.  The format is described in the Channel 
Specifications document. 
 
 
 



Preparing a Paper for SIGGRAPH

The MasterMotion Team

Abstract

We present tips on what we learned when preparing a paper
for publication. Specifically, we discuss preparing the “Tai
Chi: Training for Physical Tasks in Virtual Environments”
paper for SIGGRAPH 2002

1 Before you read this

Read the following documents, which are much more elo-
quent than this and have years of advice distilled into a few
paragraphs.

• http://www.crs4.it/ riccardo/sigpaper.html – How to
get your SIGGRAPH paper rejected

• http://www.siggraph.org/publications/prep/ – SIG-
GRAPH publication and presentation tips

• http://www.siggraph.org/publications/prep/systems.html
– How to write a good systems paper. Good advice on
all CS journal writing.

So you read those, and now you want the advice of abso-
lute novices? OK, read on...

2 Make sure its worth doing

SIGGRAPH publishes only the very best papers that are
submitted, about 10 percent of their submissions each year.
And submitting is a lot of work. Aside from the actual
project work the MasterMotion team did, we spent approxi-
mately 2 man-weeks of effort just assembling the paper (and
that time doesn’t even count the time that Jessica, Randy,
Ben, etc. put in helping us).

3 Get your tools

Odds are pretty good that this is the first paper you’ve pre-
pared for publication. If not, great, you can skip a lot of
this. But if it is the case that you haven’t done writing for
a math or CS journal, you’ll need to learn a few tools for
writing. We used a variety of tools for creating the paper
and accompanying video, and it helps to be familiar with
them in advance of preparing your paper.

For text editing we used LATEX, which if you aren’t fa-
miliar, is a typesetting language designed by Donald Knuth
for writing journal articles. It’s basically the standard for
math or CS journal articles. Because it is a markup lan-
guage, making changes and integrating the work of multiple
authors is quite simple – virtually no reformatting is nec-
essary. LATEXhandles the proper numbering for figures, in-
cluding only the referenced citations from a bibliography,
and has some very nice tools for formatting mathematical

equations. ||
−→
S′

e∈E ||
If you hadn’t guessed already, this chapter is written in

LATEX.

The specific distribution of LATEXthat we used is called
MiKTex, and has some very nice features. First of all it
is a windows distribution, and second it includes pdflatex,
which we found to be much more useful than standard latex,
simply because its native output format is PDF rather than
DVI.

For graph formatting, we used Matlab. Matlab gave us a
lot more power over our graph display than would something
like Microsoft Excel, and lets you easily seperate graph for-
matting from the specific graph you are working on. I.e. it is
simple to create multiple graphs with the same formatting,
and not as simple in Excel.

Finally, for video editing we used Adobe Premiere. It was
available, hardware accelerated on our editing machine, and
easy to learn.

4 Get your data

5 Structure of the paper

As a general tip, though you do get the chance to revise your
paper once it gets accepted, it is in your best interest to get
it as close to absolutely final as is humanly possible. The re-
viewers, smart as they are, can’t tell the difference between
unfinished work and sloppy work, and will be afraid of ac-
cepting a paper in the latter category. Spend a lot of time
going over all the spelling, grammar, visual layout, etc. of
the paper. And make sure lots of people read it, not just
you. It’s especially helpful to find people who have reviewed
papers before, and show it to them. For MasterMotion, we
were lucky enough to have Randy Pausch and Jessica Hod-
gins spend a lot of time with us editing our paper. They are
both very experienced reviewers and will be able to give you
lots of tips.

Also, the length of the paper is pretty important. 8 pages
is considered the “standard” length. Reviewers will be more
likely to accept shorter papers (but “shorter” means under
6), because more of them can be published in the proceed-
ings. Unless you have something really special, try not to go
over 8 pages. For the ETC it’s not likely that you’ll be build-
ing systems with the complexity that requires a description
over 8 pgs. It sounds short, but its really a lot. SIGGRAPH
writing is very dense.

5.1 The Video

The video is probably the most important part of a SIG-
GRAPH paper. It’s the thing the reviewers tend to look at
first, so its the best way to make a good first impression,
and its also the only place you have to really show off how
good your stuff looks. Make sure you spend the time getting
a good video. Some general guidelines are:

• Length should be around 3 minutes

• Have a good voiceover. Some accepted papers have
laughably bad narration, but yours doesn’t have to be
one of them.



• Don’t use a lot of text. This isn’t the time to animate
your powerpoint presentation.

• If your project involves unique interactions with the
computer, show people using the system, not just the
computer graphics.

• Watch your pacing. One problem with the MasterMo-
tion video is that it begins with a lot of fast cuts, and
then abruptly slows down.

5.2 The Image

A siggraph paper, especiall one coming out of the ETC,
should have an image on the front page that says it all.
Something that people will use to remember your project.
It should be the first thing the reviewers see, and something
that shows the best possible result from your system. When
people talk about your paper, they should think of the image
as they do it.

5.3 Abstract

Write this last. Once you see what argument your paper is
making and decide what is most important, then write the
abstract. Better yet, have your advisor read the paper and
write the abstract.

5.4 What we did

The first major section of the paper describes that you
did that was so special. This is only a few paragraphs,
and summarizes the major contribution that you have
made. Mention your system, your results, and why it is
new/different/better.

5.5 What others did

The “Background” section of the paper needs to be as com-
plete as possible. Be as thorough as you possibly can be in
doing a literature search. Your advisor can help here. Then
read all the papers you came up with and describe and cite
every relavent one in the background section. This can’t be
stressed enough. Failing to cite relavent sources will get your
paper rejected.

Be fair and polite in your descriptions of other peo-
ples work. Don’t say “Smith built a similar system which
sucked.” or “Smith didn’t consider factors X and Y in his
system”. Chances are that 1: Smith is reviewing your paper,
and you don’t want to piss off your reviewers and 2: Smith
did consider X and Y and either didn’t publish those results
or is still working on it. Make it clear that you are standing
on the shoulders of giants. “We extend Smith’s system in
the following ways” or “We apply factors X and Y to Smith’s
system” are much better.

5.6 How we did it

Here is where you describe the implementation of your sys-
tem and any results that you obtained. Be complete and
answer any questions that you think people may have. If
you leave things out, your paper will be rejected. If you try
to hide stuff, it’ll be rejected twice as fast (and if the review-
ers were allowed, they would probably slap you). Remember
that odds are real good that each and every person that re-
views your paper is much smarter and far more experienced
than you. They will know what you left out.

For example, the MasterMotion team wasn’t particularly
proud of how much latency was in our system (200ms). But
we had to mention it because the reviewers would want to
know, and because it could have significantly affected the va-
lidity of our results.

5.7 What it means

Here is where you discuss the results of your system. Stick
with concrete, analyzable results. If you’re doing an experi-
ment involving people, do not speculate on the nature of their
results and why they did things the way they did. Unless you
can report on things that your subjects actually said. This is
pretty standard scientific method stuff, so you already know
this. Just remember that the only thing the reviewers are a
bunch of Joe Fridays, and only want the facts.

5.8 What can we do with it now

Now you can get all enthusiastic about how great this tech-
nology is. Talk about stuff that you’ve probably already
done but aren’t ready to publish yet. Talk about stuff you
want to do to make your system better. Talk about how
many different industries can use your system.

6 The submission process

Finally you’re ready to submit your paper.
Most important thing to know here is that the SIG-

GRAPH committee takes their anonymous review process
very seriously. Make sure that the papers you submit, both
their electronic and hard copy forms, don’t include any men-
tion of the authors names, or any acknowledgements. And
always refer to previous work of yours in the third person.
Again, a non-anonymous submission is reason for rejection.

The deadline for the paper is a “recieved by” deadline, so
make sure that you get your paper and video FedExed the
day before.

Hurray! Now you’re paper is submitted. In about 2
months, you’ll know if you were accepted or not. If you
were, you have the opportunity to make major changes to
your paper. You can revise just about anything you want, as
long as you don’t change your conclusions, or take the paper
in a totally new direction. It will go through one final round
of review after the changes are make to make sure that it is
still acceptable.
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Master Motion Research Plan 
Carnegie Mellon University 

October 14, 2001 
 
Project Title:   

Master Motion 
 
Principal Investigator:   

Professor Jessica Hodgins Robotics Institute, CMU 
NSH 4228B 
(412) 268-6795 
jkh@cs.cmu.edu 

 
Experimenters:    

Todd Camill    The Entertainment Technology Center, CMU 
Philo Chua   4301B Doherty Hall     
Rebecca Crivella  (412) 268-5347  
Robert Daly   mocap@lists.etc.cmu.edu 
Ning Hu   
Russ Schaaf 

 
Proposal Abstract 
 
The primary objective of this study is to investigate how virtual reality can be used as a 
learning tool.  Specifically, the team will determine how different visual and audio 
feedback techniques affect the learning of physical movement.  CMU’s optical motion 
capture laboratory and a wireless virtual reality system will be used to measure the 
accuracy of the participants’ body positioning and create learning scenarios that would be 
impossible in real life.     
 
In the study, participants will be asked to match a virtual teacher performing several 
simple sequences of motion.  The teacher’s motions will be recorded under the Motion 
Capture Database study approved by the IRB on 9/14/01.  Each trial, the participant will 
receive different feedback regarding his or her accuracy of movement.  For instance, the 
participant may be presented with various first and third person views of his or her virtual 
self in relation to the teacher or may receive audio suggestions for improving accuracy.  
The research team will determine if any of the tested feedback techniques lead to 
significantly more accurate body positioning and if any of the techniques only possible in 
virtual reality are superior to those used in traditional learning environments.   
 
 
 



 2

Experimental Procedure 
 
Purpose of the Research 
The team is interested in how virtual reality can be used to learn physical movements.  
Investigation will focus on how various visual and audio feedback techniques affect the 
accuracy of participants’ motion over multiple trials and if any of the techniques only 
possible in virtual reality outperform those used in a traditional learning situations.   
 
Number and Selection of Participants 
We expect to use at most 100 participants throughout the study.  All will be student 
volunteers recruited from the Carnegie Mellon campus community.  We will favor 
volunteers who have no prior knowledge of the study and have never worn a head-
mounted display.  Participants will be asked to complete a survey gauging their 
experience with virtual reality, their ability to learn physical movement, and their 
knowledge of the study.  A copy of the survey has been included in the IRB application.   
 
Duration of Participation 
Each research session will last no longer than two hours.  Approximately one hour of the 
session will be used for affixing the reflective markers, calibration, and instruction.  The 
actual trials will take 30-40 minutes.  20 minutes are reserved for scheduled breaks.  The 
participant is free, however, to request a break or terminate involvement at any time 
throughout the session.   
 
Procedures 
Participants will come dressed in their own snug-fitting athletic attire or will be provided 
with a Lycra unitard to wear.  Researchers will affix reflective markers onto the 
participants’ skin and clothing with hypoallergenic tape.  Participants may have to help 
the researchers locate particular bones and joints on their body.  During calibration of the 
motion capture equipment, participants will be asked to move all of their joints through 
their full range of motion and hold certain static poses.  A head-mounted display must be 
worn for the testing itself as well as a backpack containing a two-pound battery. 
 
After calibration, participants will be asked to perform between 20 and 30 sequences of 
motion, each one minute in length.  Researchers will be continually measuring the 
participant’s body position during the trials by tracking the reflective markers with 
optical motion capture equipment.  The participant will also be video taped.  Video 
footage will be used for analysis and may be used in presentations with the participant’s 
consent.  Video will not be distributed on the web.  However, the marker data will be 
published online as well as in research publications.   
 
Foreseeable Risks and Discomfort 
The sequences of motion participants will be asked to perform will be simple and non-
strenuous.  However, if at any time during the test session, a participant feels physical 
strain or discomfort, he or she is encouraged to stop.  Some participants may feel 
awkward having the researchers physically touch them to affix the reflective markers or 
wearing the skin-tight motion capture suit.  To minimize these feeling, participants will 
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be able to wear their own snug-fitting athletic attire and can request that a male or female 
researcher affix the markers.  Use of a head-mounted display for prolonged periods of 
time has been known to cause nausea.  The participant will be encouraged to stop the trial 
if they feel dizzy or nauseous.  Any participant who chooses to end their involvement in 
the study after instruction and calibration will collect full compensation.  Both the Lycra 
unitard and the head-mounted display will be cleaned after each use.  Finally, because 
some markers are attached to the participant’s skin, he or she may feel slight discomfort 
when the markers are removed, much like pulling off a Band-Aid.    
 
Expected Benefits 
The participant will not directly benefit from participating in the study.  However, the 
study itself will add to the growing body of knowledge of how humans learn physical 
tasks and how virtual reality can be used as a learning tool.   
 
Compensation and Costs 
Participants will receive their choice of $10 cash per hour spent, paid at the end of the 
research session, or a CD with the visualization of a segment of their motion capture data, 
to be picked up by the participant a week after the test session.  The participant will not 
be liable for any costs related to the study. 
 
Confidentiality of Subjects 
 
To protect the privacy of participants, each will be assigned an identification number.  
Marker data and video footage will be filed by participant number, not by name.  
Although marker data will be freely available over the web, it will be unidentifiable as 
the participant’s marker data for all intents and purposes.   
 
Cooperating Institutions 
 
Other institutions may use the anonymous marker data published online, but will not have 
any contact with the participants. 
 
Risk/Benefit Analysis 
 
There are no known risks to participants save the minor discomforts mentioned above, 
such as pulling off the hypoallergenic tape.  The benefit of the study is the advancement 
of general knowledge of human learning and how virtual reality can be used as a learning 
tool. 
 



 
 

How can virtual reality be used as a  
learning tool? 

 
 
 

Help us find out.   
Earn $20 in 2 hours 

 

 
 
 
Email crivella@andrew.cmu.edu to sign up. 
Testing runs from:    

November 26 – December 2 
 
 

www.etc.cmu.edu/projects/mastermotion/index.htm 



Master Motion  
Research Particpant Survey      
 
 
1. Have you worn a head-mounted display before?  

 
Yes No 

 
If yes, for what reason? ___________________________  

 
2. How hard is it for you to learn physical movement or choreography? 
 

very hard     challenging     fairly easy     very easy 
 
3. How much experience do you have in…? 
 

Dance   none     a little     some     a lot 

Martial Arts  none     a little     some     a lot 

Gymnastics  none     a little     some     a lot 

Aerobics  none     a little     some     a lot 

Sports   none     a little     some     a lot 

Other_________ none     a little     some     a lot 

 
 

Particpant ID 



=============================================================== 
post survey 

=============================================================== 
 
During the experiment, we varied your and the Tai Chi master’s relative position in the 
virtual world in four trials.  You repeated each trial ____ times.  Please help us determine 
which configuration is most effective by answering the following questions. 
 
______ Trial    [motion ____]  
One copy of the master directly in front of you. 
 

1. How difficult was matching the master’s motions in this configuration?  
    very hard     challenging     fairly easy     very easy 

 
2. What made it difficult? 

 
 
 
 

3. Please rate the difficulty of this trial in relation to the other three.   
    This trial was the:   
    easiest     second easiest     second hardest     hardest 
 
4. Please access the difficulty of the motion of this trial relative to the other trials.  
    This motion was:  
    much easier     a little easier     same difficulty     a little harder     much harder 

 
 
______ Trial    [motion ____] 
Four masters at the cardinal points surrounding you.  
 

1. How difficult was matching the master’s motions in this configuration?  
    very hard     challenging     fairly easy     very easy 

 
2. What made it difficult? 

 
 
 
 

3. Please rate the difficulty of this trial in relation to the other three.   
    This trial was the:   
    easiest     second easiest     second hardest     hardest 
 
4. Please access the difficulty of the motion of this trial relative to the other trials.  
    This motion was:  

                much easier     a little easier     same difficulty     a little harder     much harder 



______ Trial    [motion ____] 
Four masters next to four copies of yourself surrounding you. 
 

1. How difficult was matching the master’s motions in this configuration?  
    very hard     challenging     fairly easy     very easy 

 
2. What made it difficult? 

 
 
 
 

3. Please rate the difficulty of this trial in relation to the other three.   
    This trial was the:   
    easiest     second easiest     second hardest     hardest 
 
4. Please access the difficulty of the motion of this trial relative to the other trials.  
    This motion was:  

                much easier     a little easier     same difficulty     a little harder     much harder 
 
 
______ Trial    [motion ____] 
Four masters superimposed on four copies of yourself surrounding you.   
One master superimposed on you.   
 

1. How difficult was matching the master’s motions in this configuration?  
    very hard     challenging     fairly easy     very easy 

 
2. What made it difficult? 

 
 
 
 

3. Please rate the difficulty of this trial in relation to the other three.   
    This trial was the:   
    easiest     second easiest     second hardest     hardest 
 
4. Please access the difficulty of the motion of this trial relative to the other trials.  
    This motion was:  

                much easier     a little easier     same difficulty     a little harder     much harder 
 
 
Comments or suggestions:  
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CARNEGIE MELLON UNIVERSITY 
 

CONSENT FORM 
 
 

Project Title Master Motion 
Conducted By The Entertainment Technology Center (ETC) 
 
You may ask any questions you have about the study now or anytime throughout the study by contacting: 
 

Principal Investigator 
  Professor Jessica Hodgins  
  Robotics Institute, CMU 
  NSH 4228b 
  (412) 268-6795 

jkh@cs.cmu.edu 
   
      
Experimenters 
  Todd Camill  camill@FRC2.frc.ri.cmu.edu 

Philo Chua  pchua@andrew.cmu.edu 
Rebecca Crivella  crivella@andrew.cmu.edu 
Robert Daly  rdaly@andrew.cmu.edu 
Ning Hu   ning@andrew.cmu.edu 
Russ Schaaf  rsbe@andrew.cmu.edu 

 
  Entertainment Technology Center, CMU 
  Doherty Hall 4301B 
  (412) 268-5347 
  
You may report any objections to the study, either orally or in writing to: 
 

IRB Chair  
Dr. Ann Baldwin Taylor  
Carnegie Mellon University  

  (412) 268-4727 
at0j@andrew.cmu.edu 

 
I agree to voluntarily participate in the observational research conducted by the students or staff of the Entertainment Technology Center under the 
supervision of Professor Jessica Hodgins.  I understand that the proposed research has been reviewed by the University's Institutional Review 
Board.  They have, to the best of their ability, determined that the observations involve no invasion of my rights of privacy, nor do they incorporate 
any procedure or requirements that may be found morally or ethically objectionable.  If, however, at any time I wish to terminate my participation in 
this study I have the right to do so without penalty.   
 
Purpose and Procedures  I understand I will be participating in a study of human learning and that I will be asked to perform several  
sequences of motion each approximately one minute in length.  I will be wearing snug-fitting athletic attire such as biker shorts or a Lycra suit.  Small 
reflective markers will be applied to my clothing or skin with hypoallergenic tape.  I will wear a virtual reality headset with small cathode ray tubes for 
the eyes called a head-mounted display and a backpack containing a 2 lb battery.   
 
During the test session, I will be video taped and the location of the reflective markers will be recorded by the optical motion capture equipment.  The 
video footage will be used for analysis and small segments of it may be used in presentations.  The marker data will be released online for use by 
other researchers indefinitely.     
 

______  I choose not to allow my video footage to be used in presentations.   
 



  Initial _________ 2

Duration  Each test session will last roughly two hours.  I may be asked to participate in multiple sessions on a volunteer basis.  If at any time, I am 
not comfortable with a task or want to discontinue the task, I have the right to do so without penalty and will inform the experimenter of my concerns. 
 
 
 
 
 
 
 
 
Compensation For participating in the study I choose to receive:   
 

______ $10 cash per hour spent, paid at the conclusion of the research session      
or  
______ a segment of my motion capture data visualized on CD, to be picked up by me a week after the research session. 

             
Privacy  I understand that I will be assigned an identification number to protect my anonymity in analysis, publication, and presentation of any 
results.  Marker data and video footage will be filed by participant number, not by name.  Although, my marker data will be freely available over 
the web, it will be, for all intents and purposes, unidentifiable as my marker data.     
 
Risks:  I understand that the researchers are committed to designing and running a study that minimizes risk to participants.  During the test 
session, I will stop doing any physical task I find physically strenuous.  I will notify the researchers if I need a break, if I am too hot or cold, or if I 
feel dizzy or nauseous.  I am aware that: removing the hypoallergenic tape may cause slight discomfort like taking off a Band-Aid, some people 
do experience nausea when wearing a head-mounted display, and the researchers will have to physically touch me in order to affix the 
reflective markers.   
 
 
 
 
 
 
I understand that in signing this consent form, I give members of the Master Motion project, and their associates, permission to present this work in 
written and oral form, without further permission from me.  I may keep a copy of this consent form for my records. 
 
 
________________________________________ ________________________________________ 
Name (please print)     Signature 
 
________________________________________ ________________________________________ 
Telephone      Date 
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CARNEGIE MELLON UNIVERSITY 
HUMAN SUBJECTS CLEARANCE REQUEST 

 
DATE:                      CMU Protocol No.      
       (for office use only) 
                                                                                                                                                                    
New Request                    Renewal     
 
 

Principal Investigator(s):                                             
 
P.I. Title/Degree:                                 Department                                                                                 
 
Phone:                              E-mail:                                             
 
Project Dates:     From             To         
 
Project Title:             
 
Name of Experimenter(s):                                                                                                                   
    
 
Source of Funding:  
 
Internal Sponsor:                                 No.          
 
External Sponsor:                                                       No.                                
 
Brief Description of Research:   
 

                                                                                                                                                                                   
 
                                                                                                                                       
 
1.  How many subjects will be used in this experiment?                       
 
2. From what source do you plan to obtain subjects?                                                  
 
3. Is there any benefit gained by the subject for participating?                                  
 
4. Will the subjects include any of the following:       NO             YES (please check below)    
    
    Fetuses    Mentally Retarded 
    Hospitalized Patients    Minors  
    Institutionalized Patients    Pregnant Women 
    Mentally Disabled    Prisoners 
                       
5. Degree of Physical Risk:               ___Negligible      ____Mild       ____Moderate     ____High 
 
6. Degree of Psychological Risk:       ____Negligible      ____Mild       ____Moderate     ____High 
 
Please submit each of the following with this Clearance Request form: 
1. A draft of the proposal or abstract 
2. A clear definition of how the subjects will be utilized or how the experimental treatment  
 will be administered 
3. A copy of the "informed" consent form(s) which the subjects will be required to sign 
4. An indication of how confidentiality/anonymity will be protected. 
5. The name(s) and address(es) of official(s) authorizing access to any subjects  
 in cooperating institutions not under the direct control of Carnegie Mellon 
6. Risk/Benefit analysis. 
7. A copy of your on-line training certificate (http://cme.nci.nih.gov/) 
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CARNEGIE MELLON UNIVERSITY 
HUMAN SUBJECTS CLEARANCE REQUEST 

 
DATE:  10-14-01    CMU Protocol No.      
       (for office use only) 
                                                                                                                                                                    
New Request      ?               Renewal     
 
 

Principal Investigator(s): Jessica Hodgins  
 
P.I. Title/Degree: Professor                Department   Entertainment Technology Center  
 
Phone:   (412) 268-6795        E-mail:  jkh@cs.cmu.edu  
 
Project Dates:     From   9/1/01      To    7/1/02     
 
Project Title:  Master Motion           
 
Name of Experimenter(s):   Todd Camill, Philo Chua, Rebecca Crivella, Robert Daly, Ning Hu,  
         Russ Schaaf 
 
Source of Funding:  
 
Internal Sponsor:                         N/A    No.          
 
External Sponsor:                                  N/A               No.                                
 
Brief Description of Research:   
 

 Use Vicon optical motion capture system and wireless virtual reality to test how  
different visualization techniques effect the ability to learn physical movement.    
 
1.  How many subjects will be used in this experiment?  100      
 
2. From what source do you plan to obtain subjects?       Volunteer CMU students   
 
3. Is there any benefit gained by the subject for participating?  Paid $20/session   
 
4. Will the subjects include any of the following:       NO   ?       YES (please check below)    
    
    Fetuses    Mentally Retarded 
    Hospitalized Patients    Minors  
    Institutionalized Patients    Pregnant Women 
    Mentally Disabled    Prisoners 
                          
5. Degree of Physical Risk:               __? __Negligible      ____Mild       ____Moderate     ____High 
 
6. Degree of Psychological Risk:       __? __Negligible      ____Mild       ____Moderate     ____High 
 
Please submit each of the following with this Clearance Request form: 
1. A draft of the proposal or abstract 
2. A clear definition of how the subjects will be utilized or how the experimental treatment  
 will be administered 
3. A copy of the "informed" consent form(s) which the subjects will be required to sign 
4. An indication of how confidentiality/anonymity will be protected. 
5. The name(s) and address(es) of official(s) authorizing access to any subjects  
 in cooperating institutions not under the direct control of Carnegie Mellon 
6. Risk/Benefit analysis. 
7. A copy of your on-line training certificate (http://cme.nci.nih.gov/) 












